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Document History

Revision Published Summary of Changes

1.0 February 2024 First revision for version 18

2.0 April 2024 Updates for version 18 monthly release - Added access permission
CancelContractAllocations.

3.0 June 2024 Updates for version 18 monthly release - Added CollateralConfig report.

4.0 July 2024 Updates for version 18 monthly release - Added margin call contract templates.

5.0 April 2025 Updates for version 18 monthly release - Added new fields for "Trade Inclusion"
under Dates & Times panel.

This user guide describes the configuration of Margin Call Contracts as well as additional
components required to generate margin calls.
For information on generating margin calls, please refer to the Calypso Collateral
Management User Guide.
For specifics on Cover Distribution, please refer to the Cover Distribution User Guide.
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1. Installation Requirements
Below is a description of how to install Calypso's Collateral Management module.

1.1 Instal lat ion
The Collateral module is installed as part of the Calypso Installer when you select Collateral Management in the
installer under Solutions(pre-packaged options for installing standard configurations). Please refer to the Calypso
Installation Guide for complete details.

When you run Execute SQL as part of your installation, all Collateral files will be already loaded, and any required
upgrade process will be performed.

1.2 Upgrade Notes
The following information is important when upgrading from a previous version of the Collateral module.

» When migrating from Calypso version 12 SP3 or earlier, you will need to run the MCC_MIGRATION scheduled task.
This scheduled task contains four attributes, Contract Notification Time, Contract Substitution Time, Contract
Valuation Time and Dispute Aging.

This scheduled task must be added to the scheduledTask domain.

Nasdaq Calypso
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» The scheduled task MARGIN_CALL is no longer used. For processing, use the COLLATERAL_MANAGEMENT
scheduled task and for reporting, the REPORT scheduled task.

» For cover distribution, the COVER_DISTRIBUTION scheduled task functions like the COLLATERAL_
MANAGEMENT scheduled task. For details on this scheduled task, refer to the Cover Distribution documentation.

1.3 Access Permissions
The following access permissions apply to Collateral functions.

Collateral Context
• Create/Modify/RemoveCollateralContext - Ability to create, modify and remove Collateral Context configuration

Collateral Manager
• AllowPrice/AllowReprice - Ability to price and reprice in Collateral Manager. A user/group can have neither

permission, one or both.

• AllowEditDisputeAgeOffset / AllowEditDirectionalDisputeAgeOffset - Ability to edit the Dispute Age Offset and
Directional Dispute Age Offset in Collateral Manager.

• CancelContractAllocations - Permission to use the "Cancel Selected Contracts allocations" and "Cancel all
Contracts allocations" options in Collateral Manager.

• RemoveMarginCallEntry - Ability to remove a margin call entry

Collateral Pool, Clearing Service, Credit Rating Scenario, Liability Group, Concentration Rule, Eligibility
Exclusion
• Create/Modify/RemoveMarginCallConfig - Ability to create, modify and remove configurations regarding

Collateral Pool, Clearing Member Contract Configuration (Cover Distribution), Credit Rating Scenarios, Liability
Groups, Concentration Rules and Eligibility Exclusions

Eligibility Exclusion
• EnforceCollateralEligibilityHardWarning - When this permission is set, a hard warning appears when a user

attempts to allocate ineligible collateral. This permission needs to be added to the function domain value and set
as a Restriction in the Access Permissions window.

When set, if the Collateral Context warning type is set to HARD, while doing the allocation the hard warning will be
displayed and the allocation will not happen. If the Collateral Context warning type is set to SOFT, the soft
warning will be displayed. Based on the user selection, that allocation can happen.

Global Credit Rating Configuration
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• Create/Modify/RemoveGlobalRatingConfiguration - Ability to create, modify and remove global credit rating
configurations

Haircut
• Create/Modify/RemoveHaircutRule - Ability to create, modify and remove haircut rules

Margin Call Configuration
• Create/Modify/RemoveCollateralConfig - Ability to create, modify and remove Margin Call Configuration

• AuthorizeCollateralConfig - Ability to authorize margin call config modifications

Margin Call Credit Rating
• Create/Modify/RemoveMarginCallCreditRating - Ability to create, modify and remove margin call credit ratings

Margin Call Reports
• Max.Collateral - The value of this User attribute determines how many margin call entries are loaded in standalone

margin call reports such as Margin Call Entries and Margin Call Allocation Entry.

If the limit is reached and not all of the margin call entries are loaded, the user receives a warning in the Data
Server log. There is no pop-up warning in the GUI at this time.

Optimization Configuration
• Create/Modify/RemoveOptimizationConfiguration - Ability to create, modify and remove an Optimization

Configuration

Wrong Way Risk Group
• Create/Modifiy/RemoveWrongWayRiskGroup - Ability to create, modify and remove wrong way risk groups

1.4 Audit
The following classes can be added to the "classAuditMode" domain for recording the corresponding audit
information:

BilateralEnry

ClearingService

CollateralConfig

CollateralContext
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CollateralExposureContet

ConcentrationRule

EligibilityExclusionConfiguration

ETLJob

ExposureGroupEntry

GlobalRatingConfiguration

InterestStatementReconciliation

LiabilityGroupcontext

MarginCallCreditRatingConfiguration

MarginCallEntry

OptimizationConfiguration

TargetConfiguration

1.5 Authorizat ion
The following classes can be added to the "classAuthMode" domain for enabling the Authorization mode:

ClearingService

CollateralConfig

CollateralContext

CollateralExposureContet

CollateralSource

ConcentrationRule

EligibilityExclusionConfiguration

ETLJob

ExposureGroupEntry

GlobalRatingConfiguration

LiabilityGroupcontext

MarginCallCreditRatingConfiguration

OptimizationConfiguration

TargetConfiguration
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1.6 Col lateral Archiving
Archiving of Collateral entries can be done via a scheduled task called COLLATERAL_ARCHIVING. This scheduled task
archives all specified entries with a context, between two given process dates. There is one table name for each table
being archived. All tables are named "table_name"_hist.

You need to specify From Days & To Days – Interval for the process date.

• Template - Used to specify the scope of contracts for which the collateral objects need to be archived. In the
Template Manager of the Collateral Manager, users can specify a collateral static data filter. This feature allows
for the archiving of VM contracts, while keeping IM contracts unarchived.
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• Collateral Context - archive all entries in selected collateral context

• Batch size – specify the number of entries expected to be archived for each Period Breakdown, for example,
Daily, Weekly or Monthly

• Period Breakdown - used to specify an archival frequency between the From Days and To Days
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2. Defining Margin Call & Clearing Con-
tracts
Margin Call Contracts are defined in the Margin Call Contract window which is accessed via Configuration > Fees,
Haircuts, & Margin Calls > Margin Call (menu action refdata.BOMarginCallConfigWindow).

Clearing Member Contracts are defined through the Cover Distribution Manager by selecting Window >
Configuration > Clearing Member Configuration.(menu action
refdata.clearing.ClearingMemberConfigWindow).

2.1 Creating a Margin Cal l Contract
Select the Edit panel, and click New to create a new margin call contract.

Enter information into the fields of the various panels as applicable. The fields are described below.

» The margin call contract is defined between Party A, a processing organization, and Party B, a legal entity.

» Margin calls will be calculated for trades between Party A and Party B that satisfy the criteria defined in the
margin call contract.

» At the top of many of the panels, there are toggle buttons for display purposes. They are:

- Click to toggle the visibility of the Description area in the panel, which gives a brief description of the
selected field.

- Click either side of this toggle to either expand or collapse the fields in the panel

Nasdaq Calypso
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Click Save to save your changes. You can also click Save As New to save the margin call contract as a new margin call
contract.

NOTE: If the Authorization mode is enabled, an authorized user must approve your entry.

Defining Margin Call Contract Templates
You can click Templates at the top of the window and save the current margin call contract as a template.

You can then load an existing template to define a new margin call contract.

2.2 Creating a Clearing Member Contract
The Clearing Member contract is used for Cover Distribution.

» The clearing member contract is defined between a clearing house and a clearing member. There are at least two
contracts involved in a cover distribution, a parent, which is the deposit contract (clearing house) and a child,
which is the liability contract (clearing member).

» A deposit contract must be created first and then a child contract can be created and linked to the deposit
contract.

» A cover distribution allocates assets from the deposit contract to the liability contract to cover exposures.

» When there isn't enough collateral in the deposit contract to cover the liability, a margin call is generated.

» At the top of many of the panels, there are toggle buttons for display purposes. They are:

- click this button to toggle the visibility of the Description area in the panel, which gives a brief
description of the selected field.

- click either side of this toggle to either expand or collapse the fields in the panel

Cover Preferences and Eligibility Exclusions are only available for Child contracts
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2.3 Margin Cal l Window Entry
Below is a description of the panels contained in the Margin Call and Clearing Member Contracts.

The fields of the Margin Call Contract are available as configurable columns in the Trade Browser when the value
CollateralConfig is added to the ExtentionTradeReportStyle domain.

F ie lds Deta i l s

Fields Description
Name Designate a name for the contract

Id / Revision # Unique id assigned by the system when the contract is saved. When the contract is saved,
the revision number increases by one.

Description Enter a description for the contract if desired.

Subtype In the Margin Call contract, the subtype options are: Master(or parent), Child and Facade
(master/parent contract with no margin call trades or margin call positions). See Facade
Setup below for more information on Facades.

In the Clearing Member contract (used for Cover Distribution) , designate whether the
contract is a Deposit contract or a Child, which is a clearing member.

(Subtype options Independent Amount and Initial Margin are used for Clearing only. For
details on these options, refer to the Clearing module user guide.)

Parent Click ... to select an existing contract. The current contract will inherit all the characteristic of
the parent contract.

The margin calls are calculated for a given hierarchy, and generated at the root contract
level. For example, a root contract is defined between PO1 and CPTY1, and children
contracts are defined between children of PO1 and children of CPTY1. The margin calls are
calculated for all children and aggregated at the PO1/CPTY1 level.

For detailed information on the Parent / Child relationships, refer to Setting up Parent/Child
Contracts

2.3.1 Part ies

Fields Description

Processing Org / Legal Entity
Role The left side of the contract will always be Processing Org and is not editable. On the right

side, select the role for the legal entity for the contact.

Processing Org / Legal
Entity

Select the processing organization or legal entity (counterparty) of the contract.

Nasdaq Calypso
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Fields Description
Full name The full name of the processing org or counterparty

Collateral Type
Collateral Type Select the type of collateral that can be used for the margin call: BOTH for cash and security

margin calls, CASH for cash only margin call, or SECURITY for security only margin calls.

Threshold
Type The Threshold is the amount of exposure that a given party is willing to bear before calling

collateral margins.

When the processing org is receiving the exposure, Legal Entity Threshold applies, and the
Counterparty will be paying the margin calls, so Legal Entity MTA and independent amount
apply as well.

When the processing org is paying the exposure, Processing Org Threshold applies, and the
processing org will be paying the margin calls, so Processing Org MTA and independent
amount apply as well.

Select the type of threshold from the Type field:

• AMOUNT — The threshold is an absolute amount. Enter the threshold amount in the
Amount field.

To always calculate a margin call, select AMOUNT and enter 0 in the Amount field.

• BIGGEST / SMALLEST— Uses both AMOUNT and PERCENT. When this is selected, the
following applies:

– First calculate the Threshold amount using the Percentage setup, which is a
percent calculation based on what is chosen in the Percentage Basis field.

– This amount is compared with what is entered in the Amount field

– The highest amount is used if BIGGEST is selected

– The lowest amount is used of SMALLEST is selected

• CREDIT RATING — The threshold is based on credit ratings prior to conversion to the
Global Rating feature. Select this option until you have converted your data over to the
Global Rating Configuration.

Select Util > View Previous Margin Call Credit Ratings to view the margin Call Credit
Rating Threshold report.

You are not able to make any changes to this report. It is from this report that you can
access the conversion tool to allow you to convert data to the Global Rating
Configuration. For details refer to Conversion to Global Rating.

• GLOBAL RATING — The threshold is based on credit ratings.

[Note:: You first need to save the contract before you can setup thresholds on credit
ratings]
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Fields Description
Click Ratings at the top of the panel to specify the threshold based on credit ratings. This
is done through the Margin Call Credit Rating Configuration window. For details on
configuring credit ratings, refer to Margin Call Credit Rating Configuration.

Note that the actual credit rating of the legal entities is specified using Configuration >
Legal Data > Entities.

• NEVER — Indicates that the threshold is never reached

• PERCENT — The threshold is a percentage of the notional. Enter the percentage in the
Percentage field and select a Percentage Basis.

Depending on the Type selection, enter either an Amount, Currency, Percentage and /or
Rating.

Amount Enter an amount here after having selected Type: AMOUNT

Base Currency When Type: AMOUNT is selected, select the currency of the threshold amount in the Cur-
rency field if you wish it to be something other than the base currency which is designated in
the Eligible Currencies panel.

Percentage Basis This field must be populated when Type: PERCENTAGE is chosen. The percentage is applied
on what is selected in this field.

• PRINCIPAL_AMOUNT — The percentage is applied on the sum of the underlying trades'
Principal Amount

• NOMINAL — The percentage is applied on the sum of the underlying trades' Nominal

• SEC_FIN_LIABILITY— The percentage is applied on the sum of the underlying trades'
SEC_FIN_LIABILITY pricer measure

• SEC_FIN_SECURITY_CLEAN_VALUE — The percentage is applied on the sum of the
underlying trades' SEC_FIN_SECURITY_CLEAN_VALUE pricer measure.

• SEC_FIN_SECURITY_VALUE— The percentage is applied on the sum of the underlying
trades SEC_FIN_SECURITY_VALUE pricer measure

• MARGIN_CALL — The percentage is applied on the sum of the underlying trades
MARGIN_CALL pricer measure

Percentage Enter a percentage when Type: PERCENT is selected. You must also select a Percentage
Basis.

Rating The selections for Rating are HIGHER or LOWER. This designates whether the higher or lower
credit rating will be used in the case where the legal entity is rated differently by one or more
of the applicable agencies.

Value Basis This field provides the ability to base the percentage on a net amount or a gross amount. This
field is available when either Percentage or BOTH is selected in the Type field.

The selection options are Net Value (which is the default) and Gross Value, which is the sum
of the absolute value of the margin call value. For example, if there are two trades which have
a margin call value of -100 and 300, the MTA/Threshold percentage is multiplied by 400 if

Nasdaq Calypso
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Fields Description
Gross Value is selected as the Value Basis.

Threshold Application This field is used with the Margin Flow Approach (which is set up in the Independent Amount
panel of the Margin Call contract.

It should be set to IA Only for netted VM and IA contracts, and for non-netted IA.

It should be set to MTM+IA for IM and non-netted VM contracts.

Minimum Transfer Amount
Minimum Transfer
Amount

The minimum transfer amount (MTA) is the amount that must be reached above the
threshold before a margin call can actually take place.

When the processing org is receiving the exposure, Legal Entity Threshold applies, and the
Counterparty will be paying the margin calls, so Legal Entity MTA and independent amount
apply as well.

When the processing org is paying the exposure, Processing Org Threshold applies, and the
processing org will be paying the margin calls, so Processing Org MTA and independent
amount apply as well.

Select the type of MTA from the Type field:

• AMOUNT — The MTA is an absolute amount. Enter the MTA amount in the Amount field.

To always calculate a margin call, select AMOUNT and enter 0 in the Amount field.

• BIGGEST / SMALLEST - Uses both AMOUNT and PERCENT. When this is selected, the
following applies:

– First calculate the MTA amount using the Percentage setup, which is a percent
calculation based on what is chosen in the Percentage Basis field.

– This amount is compared with what is entered in the Amount field

– The lowest amount is used if SMALLEST is selected

– The highest amount is used if BIGGEST is selected

• CREDIT RATING — The MTA is based on credit ratings prior to conversion to the Global
Rating feature. Select this option until you have converted your data over to the Global
Rating Configuration.

Select Util > View Previous Margin Call Credit Ratings to view the margin Call Credit
Rating MTA report.

You are not able to make any changes to this report. It is from this report that you can
access the conversion tool to allow you to convert data to the Global Rating
Configuration. For details refer to Conversion to Global Rating.

• GLOBAL RATING — The MTA is based on credit ratings.

[Note:: You first need to save the contract before you can setup MTAs on credit ratings]

Click Ratings at the top of the panel to specify the MTA based on credit ratings. This is
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Fields Description
done through the Margin Call Credit Rating Configuration window. For details on
configuring credit ratings, refer to Margin Call Credit Rating Configuration.

Note that the actual credit rating of the legal entities is specified using Configuration >
Legal Data > Entities.

• NEVER — Indicates that the MTA is never reached

• PERCENT — The MTA is a percentage of the notional. Enter the percentage in the
Percentage field and select a Percentage Basis.

Depending on the Type selection, enter either an Amount, Currency, Percentage and /or
Rating.

Amount Enter an amount here after having selected Type: AMOUNT

Base Currency When Type: AMOUNT is selected, select the currency of the MTA amount in the Currency
field if you wish it to be something other than the base currency which is designated in the Eli-
gible Currencies panel.

Percentage Basis This field must be populated when Type: PERCENTAGE is chosen. The percentage is applied
on what is selected in this field.

• PRINCIPAL_AMOUNT — The percentage is applied on the sum of the underlying trades'
Principal Amount

• NOMINAL — The percentage is applied on the sum of the underlying trades' Nominal

• SEC_FIN_LIABILITY— The percentage is applied on the sum of the underlying trades'
SEC_FIN_LIABILITY pricer measure

• SEC_FIN_SECURITY_CLEAN_VALUE — The percentage is applied on the sum of the
underlying trades' SEC_FIN_SECURITY_CLEAN_VALUE pricer measure.

• SEC_FIN_SECURITY_VALUE— The percentage is applied on the sum of the underlying
trades SEC_FIN_SECURITY_VALUE pricer measure

• MARGIN_CALL — The percentage is applied on the sum of the underlying trades
MARGIN_CALL pricer measure

Percentage Enter a percentage when Type: PERCENT is selected. You must also select a Percentage
Basis.

Rating The selections for Rating are HIGHER or LOWER. This designates whether the higher or lower
credit rating will be used in the case where the legal entity is rated differently by one or more
of the applicable agencies.

Value Basis This field provides the ability to base the percentage on a net amount or a gross amount. This
field is available when either Percentage or BOTH is selected in the Type field.

The selection options are Net Value (which is the default) and Gross Value, which is the sum
of the absolute value of the margin call value. For example, if there are two trades which have
a margin call value of -100 and 300, the MTA/Threshold percentage is multiplied by 400 if
Gross Value is selected as the Value Basis.

Nasdaq Calypso
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Fields Description

Rounding
Delivery Method

Return Method

Select the rounding method of the margin call from the Delivery Method / field. The Return
Method is used when the PO is the paying party and the Delivery Method is used when the
PO is the receive party.

• NEAREST — To round the margin call amount up or down to the nearest multiple of the
amount in the Amount field.

• UP — To round the margin call amount up to the nearest multiple of the amount in the
Amount field.

• DOWN — To round the margin call amount down to the nearest multiple of the amount in
the Amount field.

• NONE — No rounding is applied.

Enter the nearest amount to which you want to round in the field next to the selection.

Haircut
Haircut Rule Select a haircut rule that applies to the margin call calculation for collateral. The collateral

value is decreased by the haircut amount. In the Static Data Filter or Static Data Filter Tree
used in the Haircut Rule, select a product currency and designate the Product Type as Cash
or a security.

A haircut rule allows defining haircut percentages based on collateral maturities.

To display the Haircut Rule window, select Util > Haircut Rule from the Margin Call window.

Refer to the Haircut documentation for more information on a basic set up for a haircut rule.

Haircut Type Select Regular or Inverse.

The signedHaircut domain value determines the behavior of this field. When this value is set
to true (default behavior) the behavior is: 

Regular = amount • (1+ haircut)

Inverse = amount / (1 - haircut)

When the signedHaircut domain value is set to false, the behavior is: 

Regular = amount • (1- haircut)

Inverse = amount / (1 + haircut)

Note: This can be asymmetrical between the PO and LE.
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Fields Description
Apply 100% haircut on
ineligible

When the field is selected, any collateral (cash or security) that is ineligible, will have a
haircut of 100% applied to it.

To determine eligibility and which haircut rule to apply, the system refers to the party
receiving collateral:

• If PO receives, PO eligibility and haircut are checked.

• If CP receives, PO pays, and CP eligibility and haircut are checked

When returning collateral, the initial haircut is always used.

This field is asymmetrical, meaning it does not have to be the same for both the PO and CP.
The checkbox is available at both the contract and exposure group level.

Exclude Trade Haircut When checked, the haircut is excluded from exposure calculation. It is included otherwise.

NOTE: This cannot be asymmetrical. It must be the same on both sides of the contract.

Termination /
Settlement Currencies

Haircut reference currency for cross currency haircut. A haircut will be applied if the asset
being delivered is not in the same currency as one of the designated currencies. This field
can hold one or more currencies and is not mandatory. If there is no designation in this field,
the Base Currency field is used for the cross currency haircut determination.

Rehypothecation Rules
Enable
Rehypothecation

Select this if securities and cash received as collateral can be rehypothecated. When this
checkbox is selected, the Collateral Rehypothecation and Accept Rehypothecated Assets
fields are displayed.

Collateral
Rehypothecation

Select an option in the drop-down to indicate what type of collateral can be reused for this
contract. You may select CASH, SECURITY, BOTH (cash and securities) or NONE at all.

See Rehypothecation of Collateral for more information.

Accept
Rehypothecated
Assets

Select an option in the drop-down to indicate if the contract accepts rehypothecated assets.
The contract can accept, CASH, SECURITY, BOTH (cash and securities) or NONE at all.

See Rehypothecation of Collateral for more information.

Additional Legal Entities
Additional Legal
Entities

In this area you may enter additional legal entities for the Processing Org and/or the Legal
Entity

2.3.2 Deta i ls Panel
In Bilateral contracts, the Details panel contains four panels within it, Details, Ad-Hoc Details, Triparty Details and
Acadia Details.

Details
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Fields Description

Perimeter
Perimeter Type Select the perimeter type to filter which types of trades are loaded with the contract

• Collateral Exposure Trade - load only collateral exposure trades for the contract

• Trade Keyword - load only trades that have the contract's id defined in the trade keyword
MARGIN_CALL_CONFIG_ID.

• Default - load trades considering the other fields of the Perimeter

If there is a trade without any keyword, it will only be accepted in Default mode. If the trade has
a keyword, the trade will go in the margin call contract with the designated Id. If the designated
Id is less than zero, the trade will not go into any contract.

NOTE: You may run the COLLATERAL_EXPOSURE_INDEXATION scheduled task to link
collateral exposure trades to the contract Id if the collateral exposure trades were created
without the contract Id configured. (This is used for Cover Distribution only.)

Products Click to select the product types to which this contract can be applied, or ALL.

The product type can be a group of products. See Configuration > Product > Group
(refdata.ProductGroupWindow) for information on creating groups of products. Note that
the environment property USE_PRODUCT_GROUP should be set to true in order to allow
specifying margin call contracts by product group.

If you are using underlyings that are non-Calypso trades, select the product type Collateral
Exposure. Refer to Collateral Exposure for more information.

Products Filter Click to select a static data filter or static data filter tree to restrict the trades to which this
contract can be applied, or NONE.

Click the Define SD button to display Static Data Filter definition window.

Books Select the book or books to which the contract can be applied.

Currencies Click to select the currencies to which this contract can be applied, or ANY.

Exposure Type Select the underlying products for the margin call here if one of the Products selected is
Collateral Exposure.

Start Date / Time Enter the date and time on which the contract is effective.

End Date / Time Enter the date and time on which the contract will no longer be effective (these fields can be
left blank if a closing date is not know or does not apply).

Effective Date • TRADE DATE - Select if trades are to be applicable to the margin process from the trade
date

• SETTLE DATE - Select if trades are to be applicable from the settlement date. If trades are
loaded by SETTLE DATE and the transfers are not settled (transfer status is defined in
domain transferFailedStatus), they will appear with a dispute reason of "Failed Settlement"
in the Margin Call Manager, and they will be included in the margin call computation. If the
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Fields Description

transfer is settled, they will also be included in the margin call computation.

• REAL_SETTLEMENT - Choose if trades are to be applicable from the real settlement date -
In this case, if a trade or collateral has failed transfers (transfer status is defined in domain
transferFailedStatus), the dispute status is set to "Failed Settlement" and they will be
included in the margin call computation. If the transfer is settled, it will not be taken into
account in the margin call computation.

 Ⓘ [NOTE: REAL_SETTLEMENT is available and supported for Sec Finance products]

• SETTLE_DATE_OFFSET - The behavior of this effective date type is similar to SETTLE_
DATE except that an offset is applied to the value date and trades can be excluded from
exposure if maturity is between valdate and valdate + offset. This option allows for Repo
trades to be included in exposure calculations based on the expected settlement of the
repo trade while taking the margin call offset days into consideration.

• TRADE_DATE_TO_REAL_SETTLEMENT - This is used to collateralize TBA bond trades
between the trade date and the actual settlement date of the security, based on the
settlement status of the underlying transfer on the TBA trade.

When this option is chosen, a Settlement Offset field is exposed for entry. The value in this
field is used in combination with the calendar defined on the Dates and Times panel to
determine which trades have a settlement offset (in business days) greater than or equal
to the Settlement Offset field. The trades meeting this criterion will be collateralized and
loaded in Collateral Manager.

Agreement Workflow - Please refer to Calypso Acadia documentation for more information.

Agreement
Workflow Product

Product type used for Acadia Agreement Manager workflow.

Agreement
Workflow Subtype

Subtype used for Acadia Agreement Manager workflow.

Collateral
Agreement Status

Agreement status for Acadia Margin Agreement.

Workflow
Product Select a product type use for collateral workflow selection.

Subtype Subtype used in the collateral workflow. You may select a specific workflow to use for this
contract, which is defined in the collateral workflow. This list is populated from the
collateralType domain value. For more information, see Collateral Manager Workflow or Cover
Distribution Workflow.

Margin Call Generation Level - See Exposure Groups for details.
Generate Margin
Calls per Exposure

When designating a contract to use Exposure Groups , it is necessary to have Generate Margin
Calls per Exposure Group selected in the Details panel of the contract. This field is selected by
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Fields Description

Group default in the margin call contract.

• If this field is selected and there are NO Exposure Groups on the contract, Margin Calls will
be generated at the contract level.

• If this field is selected, and there ARE Exposure Groups on the contract, Margin Calls are
generated at the Exposure Group level. Workflow actions can be applied at the master
contract level as well as the Exposure Group level.

Distribute to
Exposure Group

Indicates that Collateral will be distributed to Exposure groups.

Portfolio Based
Distribution

Indicates that collateral is provided by the Exposure Groups rather than the PO's collateral
being distributed to the Exposure Groups. This is used in conjunction with the Targeted-
Allocation optimization solver.

Direction Based
Inclusion

When selected, excludes net exposure of Exposure Group from the distribution process if it is
not in the same direction as the master contract.

Details
Status When the contract is saved, the status will be set to OPEN.

If the contract is closed in the Margin Call report window, the status will become CLOSED.

NOTE: Closing a contract is available at the contract level only. A contract cannot be closed at
the Exposure Group level.

Contract Type Select the type of legal agreement that applies to the contract.

Contract types are user-defined in the legalAgreementType domain.

Contract group Select a currency group, defined in the Collateral Context window Currency Definition panel, to
be associated with the contract.

Contract Direction Choose the direction of the contract. The options are: 

• GROSS-POSITIVE: Only trades with positive MTM are displayed and included in the
exposure calculation. Trades with MTM=0 are not displayed. Used for CP demanding
margin from PO (or CP returning). The CP will not call on this.

• GROSS-NEGATIVE: Only trades with negative MTM are displayed and included in the
exposure calculation. Used for PO demanding margin from CP (or PO returning). The PO will
not call on this.

• GROSS-UNILATERAL-POSITIVE: Used to include the independent amount of all trades
where the independent amount is positive, and trades with a positive exposure only. The
Global Required Margin equals the independent amount of all trades plus the gross positive
of all trades. For calls/returns, PO can call for a new margin, CP can call for a return margin
but will never call for a new marign.

• NET-UNILATERAL: A unilateral contract is where only one party will receive collateral.
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Fields Description

– If the exposure and the independent amount are in the contract direction then
exposure and independent amount are added together for the requirement

– If there is only exposure and this is in the contract direction, then just the exposure is
used for the requirement

– If the independent amount is in the contract direction but the exposure is in the
opposite direction, then only the independent amount is used for the requirement

– If the exposure is not in the contract direction and there is no independent amount,
then no collateral requirement is created

– Independent amount should not be created in the opposite direction of the contract.
If a trade has an independent amount that is not in the contract direction, this will be
excluded from the collateral calculation

• NET-BILATERAL

Secured Party This available for selection when Unilateral is chosen for Contract Direction. Specify which
party will receive collateral.

End of Day Pricing
Environment

The pricing environment to use for an end of day, intraday and simulation allocation or cover
distribution .

The Pricing Environment Type (e.g. EOD, ITD or SIM) is chosen in the Collateral Context Pricing
tab. The Collateral Context associated with the Collateral Manager template determines which
pricing scenario to use. The Collateral Context can also be changed in Collateral Manager.

Intraday Pricing
Environment

Simulation Pricing
Environment

Include End Date
Exposure

Select this box to include end date exposure in the margin calculation. This property is based
off of the trade date (not the process date).

Exclude Delivery
Date Accruals

If true, the Accrual calculated in the Collateral Manager is only computed until the Value Date,
rather than Process Date which is the existing behavior. This attribute is false by default.

This applies only to Repo and Sec Lending.

Ignore MTA on
Returned Margin

If selected, the previous collateral will be returned when the Net Exposure changes sign. In this
case, the MTA will only be applied to the New Margin. Otherwise, the MTA is applied to the sum
of the Returned Margin plus the sum of the New Margin.

Ignore MTA on
Returned Margin
below Threshold

If selected, the previous collateral will be returned when the Net Exposure falls below the
Threshold, or when the Net Exposure changes sign.

Rounding
before MTA

Defines whether the rounding is applied before the check on the Minimum Transfer Amount
(MTA) or not.

If selected, rounding of the required margin will occur only once before it is compared to the
MTA. If rounded margin > MTA, the required margin <>0, if rounded margin < MTA, required
margin will be null.
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Fields Description

In this scenario, it is possible to have a required margin not null even though it was below MTA
before rounding

If not selected, the Required Margin is first compared with the MTA. If the Required Margin
exceeds the MTA, then rounding is performed as per the designated Rounding configuration.
Then, that amount is again compared to see if a margin call is needed.

Position Type Selecting ACTUAL bases the margin calculation on the current actual margin. THEORETICAL
bases the calculation on retical margin. EXPECTED functions in a way that treats all outgoing
margin call transfers as settled and all incoming transfers as not being available until a pre-
defined number of days has passed after the value date. This date is set in the
xferAvailableDate domain value.

Position Date Select the date when the positions are to be loaded.

• POSITION_DATE_DEFAULT is yesterday's positions

• POSITION_DATE_LAST_KNOWN is today's positions

• POSITION_DATE_PROCESS is the positions on the process date

• POSITION_DATE_VALUE is the positions on the value date

Novation Date
Based
Inclusion/Exclusion

This field facilitates Collateral Policy CSA lookup. When chosen, the logic is as follows:

• For Legacy CSAs - Trades booked and novated before the Regulatory Compliance Date
are included. Trades novated after this date are excluded.

• For Regulatory CSAs - Trades booked before the Start Date of the CSA but novated after
the Regulatory Compliance date are included.

Two additional fields are exposed when this option is chosen: 

• Regulatory Compliance Date - The date set here is used for the Novation Date Based Trade
Inclusion/Exclusion logic.

• Regulatory CSA - If selected, the contract is considered a regulatory CSA. If un-selected,
the contract is considered a legacy CSA.

NOTE: If the trade date is before the regulatory date and not partially terminated, it is subject to
legacy CSA. If the trade date is before the regulatory date, and partially terminated before the
regulatory date, it is subject to legacy CSA. If the trade date is before the regulatory date but
partially terminated after the regulatory date, it is still subject to legacy CSA. If the trade date is
after the regulatory date, it is subject to regulatory CSA regardless of whether it is partially
terminated or not.

Adjustments
Minimum
Adjustment

Enter the minimum amount by which the margin call amount can be amended in the Margin Call
report. Check the “Is Percentage” checkbox if the amount represents a percentage of the
margin call amount. If this designated adjustment amount is breached, a warning is displayed in
the Allocation window. The warning is generated by comparing the sum of all allocations
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(executed and proposed) and the Global Required Margin.

To ignore the minimum adjustment amount, enter 0 and check the “Is Percentage” checkbox.

Maximum
Adjustment

Enter the maximum amount by which the margin call amount can be amended in the Margin Call
report. Check the “Is Percentage” checkbox if the amount represents a percentage of the
margin call amount. If this designated adjustment amount is breached, a warning is displayed in
the Allocation window. The warning is generated by comparing the sum of all allocations
(executed and proposed) and the Global Required Margin.

To ignore the minimum adjustment amount, enter 100 and check the “Is Percentage” checkbox.

Trade Level Dispute
Dispute Tolerance Enter the dispute amount limit. When processing a dispute, if the dispute amount is less than or

equal to the dispute tolerance, the dispute will be automatically resolved using the
counterparty's amount.

Check the "Is Percentage" checkbox if the amount represents a percentage of the margin call
amount.

Contract Level Dispute
Dispute Tolerance • Amount - Enter the dispute amount limit. When processing a dispute, if the dispute amount

is less than or equal to the dispute tolerance, the dispute will be automatically resolved
using the counterparty's amount.

• Percentage - Enter the dispute percentage. If only Percentage is defined, that value is used
in the calculation.

• Percentage calculation base - Choose on which the percentage has to be based.

• Type - If both a dispute amount and a dispute percentage are defined, the dispute amount
is compared with the calculation of the dispute percentage and the Smallest / Biggest will
be used. None should only be selected if the amount OR percentage is defined, not both.

Track As Dispute Available only when Accept CP Amount in PO's Favor is selected. When selected, the
Counterparty’s amount is automatically taken as the Agreed Amount because it is in the PO’s
favor. In Collateral Manager the Dispute flag is checked, the Dispute Status is Partially Agreed
and the Agreed Amount is the Counterparty Amount.

Accept Undisputed
Amount

When this option is flagged, if the difference between the Global Required Margin and the
Counterparty Amount is less than the Undisputed Tolerance, the following things will
automatically happen in Collateral Manager:

• The Agreed Amount is set to the undisputed amount (which is the lowest of the two amounts)

• The Dispute flag is checked

• The Dispute Status is set to Partially Agreed

Undisputed
Tolerance

Undisputed tolerance amount, used in Accept Undisputed Amount
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Percentage
calculation basis

Choose on which amount the percentage has to be based.

Accept CP Amount
in PO's Favor

Designates to automatically accept the counterparty amount to resolve a dispute if the amount
is in the processing org's favor.

Method You may either select NONE or ARITHMETIC MEAN as a method to calculate a margin call in the
case of a dispute. If ARITHMETIC MEAN is selected, the two parties will 'split the difference'
between the two amounts when under tolerance.

Response Time Enter the time by which a response must be given to the dispute. (For information purposes
only.)

Response Time
Zone

Select the time zone that applies to the response time. (For information purposes only.)

Alternative
Procedure

Select the alternative procedure in case of a dispute: NONE, SPLIT THE DIFFERENCE (the
difference between Party A and Party B’s calculated amounts is to be split and paid/received
to/from each party), or OTHER.

This is currently for information purposes only. You can display the dispute alternative
procedure in the Margin Call Statement.

Resolution Time Enter the time by which a resolution must be agreed upon. (For information purposes only.)

Resolution Time
Zone

Select the time zone that applies to the resolution time. (For information purposes only.)

Dispute Aging Start This field defines when dispute aging begins when a margin call is disputed in Collateral
Manager. When T+1 is selected, the Dispute Age column displays 0 on the first day of the
dispute. When T is selected, the aging begins on the first day of the dispute, the Dispute Age
column displays 1 on the first day of the dispute. T+1 is the default setting.

Mirroring
Mirror Contract Select a mirror contract to for mirroring of Margin Call trades.

For details on this, see Margin Call Trade Mirroring in the Calypso Collateral Management
User Guide.

Call Generation (Clearing Member only)
Generate a Call Selecting this checkbox indicates that the call is generated at the current contract level. If this

flag is not selected on either the Deposit or the Child contract, the call is done at the deposit
level.

Distribute the call Selecting this checkbox in a child contract will generate a call per uncovered liability if the call
preference is eligible for this liability. If not, the liability call amount will be aggregated to the
total call amount done at the child contract level. If the call preference is eligible for all
uncovered liabilities, the total call amount will be equal to 0 and no allocation will be generated
at contract level.
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Excess Buffer
Requirement

The Excess Buffer is an additional amount of collateral that the clearing house requires the
member to post.

Excess Buffer Auto-
Call

If this is selected, a cash call is automatically generated when the excess buffer is breached. If
it is not selected, a notification is sent to the member, indicating the amount of the buffer that
has been used.

Use Credit
Extension

Credit Extension is an amount of cash value that the Clearing House extends to the Clearing
Member to allow them to register trades when they have insufficient available collateral.
Selecting this checkbox indicates if a credit extension is permitted.

When a Credit Extension is selected and the contract is saved, a new quote for that contract is
saved which specifies the daily credit extension amounts.

Credit extensions are ignored during a final distribution. They are only recognized during an
intraday distribution.

Credit Extension
Call Percentage

This is a % of the Credit Extension, once the Clearing Member exceeds this % the Clearing
House will call cash collateral from the Clearing Member. The Clearing Member will still be able
to clear trades until 100% of the Credit Extension is used.

For example, if the clearing member's credit extension is $10,000 with the Credit Extension Call
% of 60. If the clearing member uses less than $6,000 of their extension the clearing house
makes no call. If the clearing member uses $6,000 then the clearing member will call $6,000,
but will still allow trades to be cleared for the remaining $4,000.

Credit extensions are only applied for intraday distributions.

NOTE: Either a Credit Extension or an Excess Buffer would normally be applied to a contract, but not both at the same
time.
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Ad-Hoc Details
An Ad Hoc margin call is an option which allows contract valuation out of schedule on non-valuation days. Ad Hoc
calls may have different Valuation Time Offsets (typically T-2 instead of T-1) and often have a specific Ad Hoc
Minimum Transfer Amount to determine whether or not to generate a margin call on an off-schedule day. Any day that
is not a Valuation Date is considered an Ad Hoc date.

In the Ad-Hoc Details panel, you may indicate that Ad-Hoc calls are allowed for this contract. This flag is to be used in
conjunction with the Ad Hoc Valuation designation in the Collateral Context window.

The fields in this panel function in the same way as the valuation fields in the Dates & Times panel, except they are
specific to ad hoc margin calls in bilateral contracts only.

Triparty Details
This panel contains information related to triparty activity. Select Enable Triparty to designate that the contract is
Triparty. When this is selected, additional fields are available for input.

NOTE: If the Acadia Messaging field is checked at the Exposure Group level, different calculations are applied. A
Triparty contract uses Net Exposure calculation; A Triparty Acadia contract uses Delta calculation.

For details related to this panel, please refer to Calypso Traiparty Services documentation and Calypso Acadia
documentation.
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ECMS Details
Please refer to the ECMS section in the Calypso Collateral Management User Guide for details.

Acadia Details
The Acadia Details panel contains information related to generating AcadiaSoft messages.

For details related to this panel, please refer to Calypso Acadia documentation.

2.3.3 Dates & Times

Fields Description

Valuation
Valuation Agent Type Select PARTY A, PARTY B, BOTH, 3RD PARTY, or NONE.

Valuation Date Frequency Click to select a date rule. This rule specifies the calendars as well as the date
rolls to be used when the valuation date falls on a holiday. If a contract is not
processed based on a schedule, then a daily date rule should be defined (by
specifying a type of DAILY in the date rule configuration). A daily rule should have a
date roll of Following.

Date rules are defined using Configuration > Definitions > Date Schedule
Definitions > Date Rule.

You can may display the Valuation Date Frequency in the Margin Call Statement.

This is a mandatory field.

Valuation Time Offset Click to select a date rule used to specify the valuation offset. A valuation offset
is an agreed number of days prior to the valuation date.

The date rule in this field is typically relative to the Valuation Date Frequency date
rule. For example, if the contract has a Valuation Date Frequency of each Monday,
then the Valuation Time Offset date rule would be -1 business days relative to the
Valuation Date Frequency.

For contracts that are processed daily, the Valuation Date Frequency rule should
define as type = DAILY and the Valuation Time Offset rule should be -1 day relative
to the daily date rule.

This is a mandatory field.

Valuation Time Enter the time used to determine the date time on the Valuation Time Offset for
trade inclusion.

You can display the valuation time and time zone in the Margin Call Statement.

This is a mandatory field.
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Valuation Time Zone Select a time zone to be used in conjunction with the Valuation Time field.

This is a mandatory field.

Quote Offset Days Enter a number of offset days applied to the quote date.

Trade Inclusion (valid only for Effective Date - TRADE DATE)
Trade Inclusion Time Select the checkbox to enter the Trade Inclusion Time which is the same as the

Valuation Time.

Trade Inclusion Time Zone This field will be automatically updated based on the data extracted from the
Valuation Time Zone field.

This field cannot be edited.

Trade Inclusion Time Offset This field will be automatically updated based on the date rule saved against the
Valuation Time Offset field.

This field cannot be edited.

Calendar
Holidays This is the holiday calendar used to compute the settlement of the margin call trade.

The settlement offset of the margin call trade is computed using this calendar and
the calendar of the underlying currency of the margin call trade.

Messages
Notification Time Enter the time by which notification of the margin call must be sent or received.

Time Zone Select the appropriate time zone

Collateral Substitution
Date Option Enter “Next Settlement Date following receipt of the Transferee’s note of consent”,

“Settlement Date following the date on which the Transferee receives the new
collateral”, or enter the actual number of business days following the receipt of the
note of consent or receipt of new collateral.

This is currently for information purposes only. You can display the substitution date
option in the Margin Call Statement.

Time Enter the time by which the substitution must take place.

This is currently for information purposes only. You can display the substitution time
in the Margin Call Statement.

Substitution Time Zone Enter the time zone that applies to the Collateral Substitution Time.

Settlement Offset
If desired, designate an offset for cash and securities for each party. You may also use Collateral Dates for the offsets
by selecting the checkbox.
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Collateral Dates
In this area, you may define rules to determine the settlement dates of the collateral. Refer to Setting Collateral Dates
for information.

2.3.4 Exposure Groups
Exposure groups can be set up to meet IOSCO regulations including the 2-way movement of Initial Margin and
Variation Margin currency silos. Exposure Groups are used for Bilateral functionality as well as Buy Side Fund
Distribution. Please refer to Exposure Group Functionality for detailed information.

2.3.5 In i t ia l Marg in
This panel allows you to specify if the Margin Call Contract is associated with initial margin in the context of the
Clearing activity. The Initial Margin Buffer panel is also available for Exposure Groups.

Please refer to the Calypso Clearing Member Setup Guide for complete details.

2.3.6 Independent Amount
The independent amount is handled as a fee. Independent amounts can be either at the contract or trade level.

• Contract level Independent Amounts are credit rating based. They can be set up to be either a fixed amount or a
percentage.

• Trade level Independent Amounts can be netted with the margin call contract (included in margin call
calculations), or non-netted (excluded from margin call calculations).

NOTE: You first need to save the contract before you can setup the independent amount

Contract Level Independent Amount
» Because a contract level Independent Amount is credit rating based, the following must be defined in the Ratings

panel of the Margin Call Contract:

– Credit Rating Configuration for the processing org and/or legal entity

– Ratings Hierarchy Configuration for the processing org and/or legal entity

– Eligible Agencies (The options for this is populated from the ratingAgency domain value.)
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» Choose Rating Direction and IA Direction for the processing org and/or the legal entity

The Rating Directions are:

• HIGHER - In the case of conflicting ratings, the highest rating will be used in order to determine the contract level
Independent Amount that applies.

• LOWER - In the case of conflicting ratings, the lowest rating will be used in order to determine the contract level
Independent Amount that applies.

• NONE - No contract level Independent Amount is applied. If the rating direction is NONE, there is no contract level
Independent Amount even if an Independent Amount amount or percent is defined in the Margin Call Credit Rating
Configuration.

The IA Directions allow you to specify if an Independent Amount should always be included or not. The selections are:

• DEFAULT - The Independent Amount is included, depending on the sign of the exposure

• ALWAYS - The Independent Amount is always included

• NEVER - The Independent Amount is never included
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NOTES:

• If one of either party is set to ALWAYS or NEVER, then the Independent Amount no longer depends on the
exposure sign.

• If the IA Direction for both parties is DEFAULT, then this means that the IA is applicable to the party with the
negative net exposure. If there are no underlying trades (or if the underlying trades happen to net to 0), then there
is no paying party since the net exposure is 0. In this situation no IA value is populated since IA is not being
computed for any party.

• If the IA Direction is DEFAULT for the PO, and ALWAYS for the CPTY, and if there are no underlying trades, then
the LE IA Amount is populated and the Contract Level Independent Amount is populated with the LE IA Amount.

• If the IA Direction is ALWAYS for the PO, and DEFAULT for the CPTY, and if there are no underlying trades, then
the PO IA Amount is populated and the Contract Level Independent Amount is populated with the PO IA Amount.

• If the IA Direction for both parties is ALWAYS, and if there are no underlying trades, then the PO IA Amount and the
LE IA Amount are populated, the Contract Level Independent Amount is populated with the difference between
PO IA Amount and the LE IA Amount.

» You can click the Ratings button to display the MC Credit Rating Config window. IA Type is one of the columns
that can be displayed on this window.

The IA Type can be:

• BOTH - The AMOUNT value is compared with the PERCENT value and the value used is based on the IA BOTH
setting.

• AMOUNT

• PERCENT - percent of the notional

• NEVER - no independent amount
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When the selected IA Type is BOTH, the IA BOTH field is utilized. The options for this field are:

• Smallest: the system chooses the smallest value between the Amount and the Percentage value calculated

• Biggest: the system chooses the largest value between the Amount and the Percentage value calculated

This field is the same for the entire configuration. It is not possible to have one column set to Biggest and another to
Smallest within the same configuration. The default value is Biggest.

Below are two examples of contract level independent amounts:

Example 1

Ratings panel

Independent Amount panel

Processing Org Credit Ratings

Counterparty Credit Ratings
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Collateral Manager - Margin Call Entry

The Net Balance is greater than zero, so the Counterparty credit rating is used.

The Counterparty rating is:

Since the contract rating is HIGHER, 11,000 is used.

Example 2

(In this example, there is the same set up as the Example 1.)

Collateral Manager
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The Net Balance is less than zero so the Processing Organization's Independent Amount is used.

The Processing Organization rating is:

Since the rating direction is LOWER, 2,000 is used.

Trade Level Independent Amount - Netted
» The pricer measure INDEPENDENT_AMOUNT allows for the retrieval of that fee in reports, and revalues the

independent amount for subsequent margin calls.

» Define a fee type “IND_<name>” with or without the FeeGrid calculator, that does not generate transfers using
Configuration > Fees, Haircuts, & Margin Calls > Fee Definition. This fee will be taken into account in the margin
call calculation.
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Once you have created the fee definition, select the fee from the Type field in the Independent Amount section.

If you do not specify a fee grid, the fee amount will have to be entered manually on the trades.

Trade Level Independent Amount - Non-Netted
» Select "NON NETTED" from the Type field, and click .... It creates a sub-contract of the margin call contract with

subtype "Independent Amount" - In the sub-contract, define the independent amount as described for "Netted
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Independent Amount" - It can be manual or computed from a fee grid. The independent amount contract can be
subject to Threshold, Minimum Transfer Amount, and Rounding conventions as needed.

Fee Grid Definition (Optional)
You can click Add to define the Fee Grid with the following attributes:

• MARGIN_CALL_CONTRACT_ID = Contract id that uses the fee grid.

• MARGIN_CALL_PAYER_ROLE = Role of the independent amount payer: ProcessingOrg or CounterParty.

• MARGIN_CALL_AUTO_RECALCULATE = True to recalculate the margin call when the fee is modified at the trade
level, or false otherwise.

Margin Flow Approach
Calypso’s Margin Flow Approach is used for managing Reg IM and IA together. Possible Agreement Types are VM,
Netted (VM +IA), IM NR (Non-netted IA) and IM.

There are three methodologies for this: Distinct, Greater and Allocated.

• Distinct

• Greater Of: All Agreement Types can be used. If IM is set up as an Exposure Group, select and Exposure Group
Application. For VM, no linking is required.

• Allocated: All Agreement Types can be used. For VM, no linking is required

The Threshold Application field in the Parties panel of the contract is used with the Margin Flow Approach. It should
be set to IA Only for netted VM and IA contracts and for non-netted IA. It should be set to MTM + IA for IM and non-
netted VM contracts.

Collateral Manager fields

Collateral Manager fields that correspond to these configurations are: 

• IA Post Threshold - IA–Threshold.

• MFTA - Margin Flow Transfer Amount

– Greater: 

VM&IA or IA contract = greater of the Margin Required and the IMIA offset
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IM contract: If Abs(MFTA of IA) > Margin Required of IM contract then = -MFTA of Netted VM&IA contract +
Required Margin IM contract; otherwise it is 0

– Allocated / VM&IA or IA contract: 

If Margin Required of IM contract < IA post threshold of IA contract, -Margin Required of IM contract

If Margin Required of IM contract > IA post threshold of IA contract, -IA Threshold of IA contract

• Revised IA - on VM&IA or IA contracts, this is IA post Threshold + MFTA

• Margin Required Post MFA - on VM&IA or IA contracts = Margin Required + MFTA

The table below describes this is as well.

Mcc
Type

IA Post
Threshold

MFTA Revised IA Margin
Required
Post MFA

Greater IA IA Threshold –IA post Theshold IA post
Threshold +
MFTA

Margin
Required +
MFTA

IM N/A If abs value of MFTA VM&IA contract > Margin
Required of IM contract, then =–MFTA of VM&IA
contract + Required Margin IM contract

Otherwise, 0

N/A Margin
Required +
MFTA

Allocated IM N/A N/A N/A N/A

IA IA –
Threshold

If Margin Required of IM contract < IA post
threshold of IA contract, then =–Margin Required
of IM contract

If Margin Required of IM contract > IA post
threshold of I A contract, then =– IA Threshold of
IA contract

IA post
Threshold +
MFTA

Margin
Required +
MFTA

The following additional Collateral Manager fields are not Margin Flow specific but are affected by its implementation:

• Trade Margin - IA post Threshold + MTM

• Constituted Margin - refers to new Margin Required (MFA)– Total Previous Margin

• Return / New Margin - To determine the return and new margin and their rounded values, the Margin Required
post MFTA is compared with the Previous Margin

2.3.7 Addi t iona l Info
You can select the Additional Info panel to enter a comment for the contract and to set margin call contract attributes
(fields).
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Out-of-the-box attributes are described below.

By default the attributes are associated with a category: CFD, Template or Others.

You can create new fields and new categories by clicking .

» Enter a field name.

» Click to add a new category and select the new category.

» Click Apply when you are done.

Fields are added to the domain "mccAdditionalField".

The available values of a given field can be defined in the domain "mccAdditionalField.<field>".

Example: Domain "mccAdditionalField.MARGIN_TYPE" contains available values for the field MARGIN_TYPE.
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If such domain does not exist, the field is a free text field.

Categories are added to the domain "mccAdditionalCategory".

Mapping between new fields and new categories is added to the domain "mccAdditionalCategory.Field" in the form:

Value = <category>.<field>

Example:

If you want to move an existing field to a different category, you need to add it to the domain
"mccAdditionalCategory.Field".

Example:

Value = Clearing.CCP will move the field CCP from the Others category to the Clearing Category.

Out-of-the-box Attributes (Fields)

Fields Description

CFD
BOTH_MARGIN For CFD margin call contracts, if this is true with a negative variation

margin (VM), NB will be negative. If this is false, with negative VM, NB will
only show deposit annex (initial margin) with positive VM, NB will be
positive.

NO_MARGIN For CFD margin call contracts, if this is true, NB will show only the deposit
annex (initial margin). If this is false and the variation margin is negative, NB
will show only the deposit annex (initial margin). If the variation margin is
positive, NB will be positive.

RST For CFD margin call contracts. In this field, define the legal entity (short
name) that the provider will pay the dividend to if the provider has a long
position.

Template
DETAIL_TEMPLATE_ID Contains the ID of the default template to load the Margin Call Details

report - It is automatically set, when you choose Report > Link Template
to Contract in the Margin Call Details report.

MC_DETAIL_PROPERTY_TEMPLATE_ID Contains the ID of the default template to load the Margin Call Property
template.
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Fields Description

MC_PROPERTY_TEMPLATE_ID Contains the ID of the default template to load the Margin Call Details Prop-
erty template.

Others
ACCOUNT_NAME Account name

ALWAYS_ROUND_RETURN_MARGIN This must be set to True to perform rounding on a returned margin call.
When this is set, the returned margin will be rounded to UP or DOWN as
per the Rounding setup on the contract.

CCP

These attributes are related to the Clearing module. Refer to the Clearing
documentation for more information.

CCP_ORIGIN_CODE

CCP_REFERENCE

CCP_SEGREGATION_ACCOUNT

CLIENT_TRANSFERS This setting decides if client transfers will impact the margin call position
for that contract.

The values can be:

• Exclude (client transfers will be excluded from the Margin Call position
except for Interest Bearing trades)

• Include as Client (client transfers will be included in the Margin Call
position as a Client position)

• Include as Internal (client transfers will be included in the Margin Call
position as an Internal position)

The default is Include as Client

CVA_COLLATERAL_POLICY This field selects the Collateral Policy used to assign a risky curve for
calculation of proxied CVA pricer measure.

DISPUTE_COMMENT_MANDATORY True if a dispute comment is mandatory when resolving a dispute. Default
is false.

EXCLUDE_ACCOUNT_FROM_
INTERACOUNTXFER

Domain name used to exclude a Margin Call contract from the Inter
Account Transfer.

EXCLUDE_REPO_INTEREST Set this to True to exclude interest on Repo trades from the margin
calculation. Set to False if the Repo interest is to be included. Default is
False.

EXCLUDE_SECLENDING_INTEREST Select true to exclude interest on the SecLending trade from the margin
calculation. Select false if you would like the SecLending interest to be
included. Default is false.

HAIRCUT_ON_CLEAN_PRICE When set to Yes, the haircut will be applied on the clean price instead of
the dirty price. The default, or value for no entry is No.
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Fields Description

IGNORE_ALLOW_EX_DIVIDEND When this is set to True, the ALLOW_EX_DIVIDEND pricing parameter is
ignored. This is used when a GILT bond falls under the ex-dividend period.

IM_IMPORT_CURRENCY Governs how margin numbers are imported, either in their requirement
currency or the native currency.

INCLUDED_VM_FLOWS Comma separated list of transfer types explicit to this Margin Call contract.
If the list is empty, the contract will accept any transfer not listed on
another of this LE's VM Margin Call contract.

INCLUDE_CLIENT_TRANSFERS If set to true, Client Transfers will be included in the Margin Call position for
the contract.

INTEREST_DAILY_ROUNDING When set to true, daily interest amounts are rounded then summed. When
not set, un-rounded daily interest is summed and then the total is rounded.

This only applies to margin call calculation and not to interest bearing.

INTEREST_DATERULEONLY Select true for interest to be computed based only on frequency of the
date rule attached to the margin call contract regardless of positive or
negative MTM moves. Select false for interest to be computed based on
frequency UNLESS there is a switch in the MTM move.

IS_SETTLE_DATE_ACCRUAL_CALC When set to true, the accrual of previous positions is not affected (shown
in the Netted Positions panel), but the accrual will change in the Allocation
panel (in Collateral Manager). Both the bond settle offset days and the
contract settle offset will be considered. The calculation is val date +
maximum (settle date offset of contract OR settle date offset of bond).

The default setting is false or left blank.

RECON_INTEGRATION Used to define integration type for reconciliation on margin call entries.
This includes reconciliation of bilateral and cleared VM flows. FCM and
internally calculated VM flows are shown in Collateral Manager to cross
verify the final call amount.

The choices for this field are Collateral-Bilaterial-VM, Collateral-Cleared-
VM-ETD or Collateral-Cleared-VM-OTC.

Based on the selected integration type, the system looks for the
Recon.Integration.<integration type> domain to get the mandatory fields.

 Ⓘ NOTE: The Reconciliation panel is visible after you set Value =
true for the domain value "UseCollateralManagerReconciliation" - its
default value is set as false.

Please refer to the Calypso Reconciliation Service documentation for
additional information.

Reinvest Coupon Used for Corporate Action management. If set to true, then an additional
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Fields Description

Corporate Action trade counterparty linked to the margin call contract will
be created to impact the margin call position.

Reinvest Principal This works similarly to Reinvest Coupon except it is for a redemption event
in order to reinvest the principal.

RISK_CCY If a currency is present in this field, the FX haircut will be based on the
static data filter or static data filter tree. The static data filter or static data
filter tree can contain cash and securities.

SLM Stress Loss Margin

When set to True, SLM PL measure (PL type as None) will be considered in
calculation.

When set to False, SLM PL measure is not considered.

Note: The Collateral.Multiplier domain must contain the value of Buffer for
the SLM attribute to work properly.

SEND_STATEMENT

SEPARATE_VM_SETTLEMENT A value of True designates this Margin Call contract as contributing to the
Separate Settlements section of the Client statement. Any other value will
associate the Margin Call contract with the Financial Summary section.

SFTR_REPORTING Set to true if the contract is eligible for SFTR reporting.

Refer to Calypso SFTR documentation for details on Securities Financing
Transaction Regulation.

SLM This attribute is used for Stress Loss Margin. The options are: 
l True - SLM PL measure (PL type as None) will be considered in cal-

culation
l False (or blank) - SLM PL measure is not considered

NOTE: The Collateral.Multiplier domain must contain the value of Buffer for
the SLM attribute to work properly.

USE_RECONCILIATION Select true if Reconciliation should be used on the contract.

USE_RAW_PRICE This attribute allows collateral valuation to be defined using the raw quote
price. Set to False by default.

CVD_ROUNDING_DECIMAL The amount set in this field is used to round all values in the Cover
Distribution calculation. If the field is left blank, the rounding is done based
on the Currency definition.
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2.3.8 Documents
You can add documents to the margin call contract from the Documents panel.

Displaying Existing Documents
You can click Load on the right-hand side to load existing documents associated with the margin call contract.

You can double-click the document to open it.

Adding Documents
To add a document to the margin call contract, enter a document name, description and effective date then select the
document from the Document field. Then click Add.

The document is added to the right-hand side.

Click Save to save the document. The document is saved to <user home>/AppData/Local/Temp.

You can double-click the document to open it.

2.3.9 E l ig ib i l i ty
The Eligibility panel contains:

• Eligible Books - Select the books eligible for allocation

• Eligible Securities - Select the securities available as collateral

• Eligible Currencies - Mandatory for Cash margins. At least one deliverable currency must be defined

Eligible Books
In the Eligible Books panel, the books eligible for allocation are defined. This is also where the default book is defined.
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Defining books in this panel is a two step process. The first step requires you to designate which of the following
books are eligible for allocation. The selection options are:

• Contract - PO books: Books belonging to the PO of the margin call contract

• Contract - Parent LE books: Books belonging to the parent legal entity of the contract

• Parent contract - PO books: Books belonging to the PO of the parent contract

• Parent contract - Parent LE books: Books belonging to the parent legal entity of the parent contract

• Sibling contracts - PO books: Books belonging to the PO of other children margin call contracts

Step 1 - Click to add Legal Entity Books.
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Step 2 - You may filter the eligible books by Name, Attribute or Static Data Filter or Static Data Filter Tree.

Step 3 - Choose the perimeter for the books in the Legal Entity Books field. The various perimeters are detailed above.

For type name, you may select all eligible books in the perimeter.

Step 4 - Specify the default book for Incoming Security, Incoming Cash, Outgoing Security and Outgoing Cash. It is
also possible to designate that the inventory source book be used for cash, securities, both or not at all. A designation
in this field overrides the default book selections.

Only books that belong to the PO (or one of its parents), and have the attribute CollateralHolding set to True, are
available for selection.

(LE_HOLDING_BOOK) is not used.

Nasdaq Calypso
Collateral Configuration / Version 18



Eligible Book Attributes

Attributes chosen in the Book window of an eligible book can be added as columns in Collateral Manager and
Collateral reports and notifications.

Book Attribute setting in Book Window

• Eligible Book attribute CMF_ID set as ID1

Column display in Collateral Manager Results

• Column MarginCallConfig.Incoming Security Book Attributes.Attribute.CMF_ID shows ID1.

Nasdaq Calypso
Collateral Configuration / Version 18

April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 50 / 170



April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 51 / 170

Eligible Securities
For security margins, select the securities available as collateral.

In order to specify eligible securities to use for collateral, you must have a static data filter or static data filter tree set
up that covers all of the eligible securities that you would like to use for collateral. The Static Data Filter window is
available through Configurations > Filters > Static Data Filter.

To view the Static Data Filter Tree window, in the Calypso Navigator, add a menu item for the Static Data Filter Tree
window (menu action refdata.StaticDataFilterTreeWindow).

The static data filter must have a Product Type defined. If using a static data filter tree, the root static data filter must
include Product Type in its criteria.

See Static Data Filter for information on creating Static Data Filters and Static Data Filter Trees.

It is possible to flag the PO and LE to share the same Eligible Securities or to enable each to have their own list of
Eligible Securities. For the PO and LE to have their own sets of securities, select the Asymmetrical LE Eligible
Collateral flag and/or Asymmetrical LE Excluded Collateral flag.

Nasdaq Calypso
Collateral Configuration / Version 18



Nasdaq Calypso
Collateral Configuration / Version 18

April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 52 / 170



April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 53 / 170

Static Data Filter Tree chosen in PO Eligible Collateral

» It is possible to exclude products from eligibility using a static data filter or static data filter tree in the Excluded
Collateral section. This exclusion overrides whatever is defined as eligible collateral above. For example, you may
have a filter containing government bonds but wish to exclude bonds from certain countries.

» Additionally, an Exclusions column can be added to the Allocation window. A hard warning can be configured for
this exclusion functionality using the EnforceCollateralEligibilityHardWarning access permission.

» There are three static data filters that can be used to improve filtering based on rating agencies. For the filters to
work, the rating acceptance criteria must be the same for all agencies. For example, securities are eligible if rated
at least AA- by S&P or Aa3 by Moody’s. These static data filters can then be used in the Margin Call Contract >
Eligibility > Eligible Securities definition. The filters are found in the Static Data Filter window under Product >
Rating > Global Rating.

– LowerIssueGlobalRating: Ratings must be within the range defined. If both ratings are provided, the lowest
rating will be used. If a rating is missing or an ‘ignored value’, the available rating is used.

– LowerIssuerGlobalRating: Ratings must be within the range defined. If both ratings are provided, the lowest
rating will be used. If a rating is missing or an ‘ignored value’, the available rating is used.

– LowerIssueThenIssuerGlobalRating: The system first refers to the issue rating. If the issue rating is within
the range defined, it is accepted. If both are provided, the system refers to the lower rating. If only one is
provided, the available rating is used
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The system only refers to the issuer rating if there is no issue rating or there is an ‘ignored rating’. When referring
to the issuer, the rating must be within the range defined for the filter to be accepted. If both are provided, the
system refers to the lower rating. If only one is provided, the available rating is used.

In this case, the contract accepts bonds with a Global Rating Valule of 0, 1 or 2 and the system accepts the lowest
rating.

 Ⓘ NOTE: When selecting a static data filter for a security, the filter should be associated with the group ANY
or Margin Call.

Eligible Currencies
It is possible to flag the PO and LE to share the same Eligible Currencies or to enable each to have their own list of
Eligible Currencies. For the PO and LE to have their own sets of currencies, select the Asymmetrical LE Eligible
currencies flag.

 Ⓘ [NOTE: For cash margins, you MUST define at least one Eligible Currency]

Fields Description

Contract Currency
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Fields Description
Base Currency Select the default currency for margin calls.

Collateral Policy The Collateral Policy is not used in the valuation of margin call contracts. It is used when
pricing trades associated with a margin call contract for selecting the appropriate
discount curve.

Collateral policies are defined in the domain CollateralPolicy. Select a policy as needed. In
the Pricer Configuration, curves can be defined by collateral policy. Please refer to
Calypso Collateral Pricing documentation for details.

Settlement Cut-Off Defines the time frame (when compared to currency Settlement Cut-Off time) within
which a warning should appear when the user is saving a margin call trade with that
currency. Set time in minutes.

To allow for the Trade Date and Settlement date to be the same date, set this to zero.

Minimum Repay
Threshold
(Cover Distribution)

This threshold is used in conjunction with the Auto Repayment flag on the Eligible
Currency Definition window. This threshold value is expressed in the contract currency
and each currency balance is converted to the contract currency and compared against
this threshold when determining if Auto Repayment is to be executed. This is used only
for final distributions in Cover Distribution.

Interest
Interest Type Define the Interest Payment Type

Interest Date Rule If the interest is to be calculated on a regular basis, click ... to select a date rule.

Date rules are defined using Configuration > Definitions > Date Rule Definitions.

Interest Date Rule Only Select if you want the interest to be compounded only based on the frequency defined
above. De-select if you want to compute interest based on frequency , unless there is a
switch of sign in the mark to market move.

Roll Interest to Principal Check to roll the interest into the margin call position. It creates a position of class
Margin_Call and type Rolled_Interest for the computed interest.

This Rolled_Interest position is added to the computation of the exposure on the following
day.

Note: To see rolled interest reflected on Netted Positions and Global Required Margin,
add the value ROLLED_INTEREST to the flowType domain.

Cash Margin Call Account If you select this checkbox and Orderer Role = Client, the Cash margin call will also be
generated to a dedicated account, allowing separate interest payments.

See Paying Interest Separately for complete setup details.

Security Margin Call
Account

If you select Cash Margin Call Account, and Orderer Role = Client, the Security margin call
will also be generated to a dedicated account, allowing separate interest payments.

This setting should NOT be selected if using MT569 import method to generate margin
calls.

See Paying Interest Separately for complete setup details.
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Fields Description
Orderer Role This is used to set the role (client or customer) of the legal entity in the case of Cash

Margin Call Account and/or Security Margin Call Account is selected.

To add a deliverable currency, select in the Eligible Currencies portion at the bottom of the window to display the
Eligible Currency Definition window.

Select the desired information and click Apply. The fields of this window are described below.

Repeat as needed for other deliverable currencies. They will be available for selection when computing margin calls.

NOTE: To modify a deliverable currency, select a currency, and either double-click on the row or click . Modify
the fields appropriately and click Apply.

Fields Description
Currency Select a deliverable currency, and specify how the interest on margin calls in this currency

will be calculated. It is mandatory to specify at least one deliverable currency.

Note that it is optional to specify how interest on margin calls is computed, in particular if
you want to pay the interest separately from the margin calls.

See Paying Interest Separately for details.

Compounding
Check the “Compounding” checkbox to compound the interest.

Include Interest to Position
Check the “Include Interest to Position” checkbox to include the interest on cash margins in
the Margin Call position. Interest is computed on the Actual position.

Project Interest to Position
This only applies if “Include Interest to Position” is checked.

Nasdaq Calypso
Collateral Configuration / Version 18

April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 56 / 170



April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 57 / 170

Fields Description
In this case, the interest added to the position is computed on the Theoretical position
rather than the Actual position.

Adjustment Currency
When checked, the margin calls are calculated in the corresponding currency by default. If
it is not checked for any currency, the margin calls have to be created manually using
Margin Call > Allocation in the Margin Call Manager. When an Adjustment Currency is
specified, the Cash Margin column will populate in the Margin Call Manager with the
adjusted currency amount.

You must also be sure that the AutoAdjust workflow rule is assigned to the appropriate
workflow action.

Example: PRICED_PAY - AGREE_EXPOSURE - EXPOSURE_AGREED

Both the workflow rule and the "Adjustment Currency" checkbox are necessary for the
currency amount to be adjusted automatically.

Call Cut-off
The Call Cut-off field is available only if the Adjustment Currency checkbox is checked. A
cutoff time should be entered.

The cutoff is applied to the adjustment currency.

Because multiple currencies can be flagged as an Adjustment Currency, the currencies are
allocated based on the order in which they are defined in the Eligible Currencies panel and
whether the first currency in the list has a holiday. If the first currency in the list has a
holiday, a call is generated with the next currency in the list.

If only one currency in the list has a holiday, a call is generated with the next currency in the
list.

If only one currency is an Adjustment Currency and it has a holiday, the margin call is
generated on the next business day. If a currency has Adjustment Currency selected but no
cutoff time, it is only considered for a holiday scenario.

For example:

GBP ccy, adjustment ccy - YES, cutoff time 4pm

EUR ccy, adjustment ccy - YES, cutoff time 6pm

USD ccy, adjustment ccy - YES, cutoff time 5pm

JPY ccy, adjusment ccy - YES, cutoff time NULL

If it is before 4pm, GBP is used.

Nasdaq Calypso
Collateral Configuration / Version 18



Fields Description
If it is after 4pm but before 5pm, USD is used.

If it is after 5pm but before 6pm, EUR is used.

If it after 6pm, a call is generated in GBP for tomorrow unless tomorrow is a holiday for GBP.
If that is the case, it is generated in EUR because it is the second currency in the list.

JPY would not be considered at all since it has no time. However, it would be considered if
the first 3 currencies were on holiday.

Explode Return/New Margin
Provides the ability to explode the New Margin and Return Margin into two different
allocations. If set to true, the system generates allocations as described below. This
checkbox is available only if the Adjustment Currency checkbox is selected. The following
behavior is for no dispute, dispute/partially agreed or fully disputed/resolved by PO: 

• NewMargin – A cash allocation is created with the type Margin using the New Margin
value. If New Margin > 0, the direction is Receive. If New Margin < 0, the direction is
Pay.

• Return Margin – A cash allocation should be created with the type Return using the
Returned Margin value. If Return Margin is > 0, the direction is Receive. If Return Margin
is < 0, the direction is Pay.

• NewMargin + Return Margin – There are two cash allocations. A cash allocation is
created with the type Margin using the New Margin value. If New Margin > 0, direction
is Receive. If New Margin < 0, direction is Pay. Also, a cash allocation is created with the
type Return using the Return Margin. If the Return Margin > 0, the direction is Receive. If
the Return Margin is < 0, the direction the direction is Pay.

There are three workflows used to accommodate the three auto adjust options. These
workflows should use a full STP workflow. When using these workflows rules, there is no
need to open the Allocation window. The Margin Call entry goes through the workflow
transition anatomically. The workflow rules are: AutoAdjust, AutoReturn and
AutoReturnAndAdjust. These rules should be added to a transitions such as:

EXPOSURE_AGREED - ALLOCATE - ALLOCATED

ALLOCATED - VALIDATE - VALIDATED

 Ⓘ NOTE: Currently, the Auto Adjustment feature is not available for dispute cases.
This functionality will be available in a future release.

Auto Repayment
This feature is available for Clearing Member Configuration. Select this option to repay
excess cash collateral in the deposit contract for any deposit currency which is above the
Minimum Repay Threshold. This is applicable for Final Distribution only.

Fixed Rate
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Fields Description
Select the Fixed Rate radio button and enter a rate for the currency that will be used to
calculate interest on the margin calls.

Floating Rate

For a Floating Rate, select the radio button and choose the reference index, tenor, and
source. Enter the spread and factor if needed.

2.3.10 Concentrat ion & Limits
This panel allows you to add Concentration Rules to the Margin Call or Clearing Member Contract.

See Concentration Limits and Margin Call Contracts for detailed information on entering information here.

2.3.11 Opt imizat ion
The Optimization panel allows you to designate certain functions related to the optimization of collateral, which is
done in the Collateral Manager.
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Fields Description

Exclude From
Optimizer

Select this check box to exclude the contract from optimization.

Reset
Allocations If
Not Fully
Allocated

This defines whether the optimizer can partially allocate margin call contracts or not. It affects
contracts that accept SECURITY only. This may also be set as an Optimization Constraint. The
options are:

• Never - The optimizer will be allowed to do partial allocations of contracts

• If Not Fully Allocated - The optimizer resets allocations (does not suggest any allocations) if the
contract is not fully allocated due to insufficient inventory (i.e. there is an remaining margin)

Cash
Optimization
Currency

When gathering a list of eligible assets for a contract, when fetching eligible cash, the system checks
whether an optimization currency is defined. If there is, then the optimizer behaves as if this is the
only eligible currency so that it will use this currency over another currency with a lower weight in the
Target configuration when there is no non-cash collateral available, or as the adjustment currency
when filling the remaining margin.

The currencies listed are the LE eligible currencies.
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Fields Description

Substitution
Level

Select the level of substitution desired for this contract. You may choose to either inherit the
substitution method from the Optimization configuration, or define a method to be used specifically
for this contract.

Substitution
Method

When Redefined is selected as the Substitution Level, this drop-down box is displayed. You may
select either Never, By Rule or Always. Refer to optimization substitution for more information. When
By Rule is selected, designate the rule or rules in the area at the bottom of the window.

Substitution
Context

In relation to either the By Rule or Always Substitution Methods, select to substitute either when the
contract is paying a margin OR paying or receiving a margin.

2.3.12 Conf igurat ions

Child Configurations
Within this panel contains the Child Configurations panel. This panel displays all of the child contracts associated with
currently selected parent contract. You may double-click on the child contract to open its contract window.

The parent contract is displayed in the Name field and the child contracts are displayed in Child Configurations

Linked Configurations
This panel is used for IM/VM and VM/IM movement of excess collateral between accounts. For details on how this
panel is used, refer to the Calypso Clearing documentation.

2.3.13 Clear ing Serv ices
This panel is used to define the subscriptions to the clearing services for Cover Distribution. Clearing services on the
deposit contract are used to determine eligibility for lodging assets. It is not necessary to define clearing services on
the child liability contract because the eligibility for any exposure is defined by the liability group to which it belongs.
Each liability group specifies the applicable clearing services, and each clearing service contains an eligibility set.

This is available in the Clearing Member contract only.
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Category A, B and Cash clearing service can take securities filtered with a specified static data filter and USD cash

» Click to add a new clearing service.

» Excess Buffer can be set up as a clearing service.

» In the Clearing Service Configuration window, designate the eligibility requirements and attributes associated
with the clearing service.

2.3.14 Cal l Preferences
In this panel, you can define the preferred assets to use when there is a margin call necessary because there is not
enough deposit available to cover the liability in a cover distribution situation. This is available in the Clearing Member
contract only for Deposit contracts. This type of designation allows you to specify the type of call that you desire at a
designated time.
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» Click to create a new Call Preference and enter the fields below.

» Then click Apply.

Field Description

Type Select either TYPE_CASH or TYPE_TRIPARTY

Currency If TYPE_CASH is selected, specify the currency of the call.

Product Id System defined id number of the definition in the case of TYPE_CASH. For TYPE_
TRIPARTY, enter the product id, as they are modeled as bonds.

Start Time The earliest time that the call can occur

Holidays Specify observed holidays, automatically populates default holiday calendar for the
designated Currency.

MTA Type Minimum transfer amount type.

• AMOUNT — The minimum transfer amount is absolute. Enter the minimum
transfer amount in the Amount field.

To always calculate a margin call, select AMOUNT and enter 0 in the Amount
field.

When Amount is selected, select the currency of the transfer amount in the
Currency field if you wish it to be something other than the base currency
which is designated in the Eligible Currencies panel.

• CREDIT RATING — The minimum transfer amount (MTA) is based on credit
ratings prior to conversion to the Global Rating feature. Seslect this option until
you have converted your data over to the Global Rating Configuration.
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Field Description

Select Util > View Previous Margin Call Credit Ratings to view the Margin Call
Credit Rating Threshold Report.

You are not able to make any changes to this report. It is from the report that
you can access the conversion tool to allow you to convert data to the Global
Rating Configuration. For details refer to Conversion to Global Rating.

• GLOBAL RATING — The minimum transfer amount (MTA) is based on credit
ratings.

[Note: You first need to save the contract before you can setup MTAs on credit
ratings]

Click Ratings at the top of the panel to specify the threshold based on credit
ratings. This is done through the Margin Call Credit Rating Configuration
window. For details on configuring credit ratings, refer to Margin Call Credit
Rating Configuration.

• MC_PERCENT — The MTA is a percentage of the total margin call. Enter the
percent in the Percentage field.

• PERCENT — The MTA is a percentage of the threshold amount. Enter the
percentage in the Percentage field.

Depending on the Type selection, enter either an Amount, Currency, Percentage
and /or Rating.

The selections for Rating are HIGHER or LOWER. This designates whether the
higher or lower credit rating will be used in the case where the legal entity is rated
differently by one or more of the applicable agencies.

MTA Amount The minimum transfer amount (MTA) is the amount that must be reached above the
threshold before a margin call can actually take place.

2.3.15 Cover Preferences
In this panel, you can designate which liabilities to cover in which order. These cover preferences can then be called
upon in the Collateral Allocation Rule designation in the Optimization configuration.

This is available in the Clearing Member contract only for Child contracts.
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In the above example, cash in the same currency as the liability and any liability group will be used first to cover. Then,
cash in any other currency and any liability group. After that, securities will be used in the same currency as the
liability, followed by securities in any other currency.

2.3.16 El ig ib i l i ty Exc lus ions
The Eligibility Exclusions panel enables you to specify what type of cash or security that CANNOT be used to cover a
liability. In this panel, you are able to specify the Liability Currency, Liability Group, Liability Type, Cover Currency as
well as a Static Data Filter or Static Data Filter Tree.

See Static Data Filter for information on creating Static Data Filters and Static Data Filter Trees.

You are also able to specify if assets should be excluded if they are not defined as Cover Preferences.
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In the above example:

• For the Liability Currency GBP and for the Liability Group Group 1, Cash is not eligible to be used to cover

• For the Liability Currency GBP and for the Liability Group ExcessBuffer, GBP is not able to be used to cover

• For any Liability Currency in the Liability Group Group 2, government bonds are not eligible to be used to cover.

• For the Liability Currency USD and the Liability Group Category B, GBP is the only currency eligible.

2.3.17 Rat ings
Credit Rating configuration is completed through the Ratings panel. For detailed information on this panel, please
refer to Margin Call Credit Rating.
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This panel is used in bilateral contracts only.

2.4 Uti l Menu
Below is a description of the menu options in the Util window.

Collateral Context
Displays the Collateral Context window, which allows you to add product specific columns that are accessible in the
Underlying panel of Collateral Manager.

Concentration Rule
A concentration rule is a group of concentration limits.Select this option to display the Concentration Rule
Configuration window.

Haircut Rule
The Haircut Rule window allows you to define rules to apply haircut percentages based on security maturities. Select
this option to display the Haircut Rule window. for more information on this window, refer to the Trading Env
documentation.

Global Rating Configuration
Displays the MC Rating Config window. In this window, you can create margin call credit rating configurations as well
as set global rating configurations which can include multiple credit rating agencies.

Optimization Configuration
The collateral optimization function of Calypso allows you to allocate collateral payment by making the best use of the
inventory. Select this option to display the Collateral Optimization Configuration window.

Collateral Exposure Context
The Collateral Exposure portion of Calypso's Collateral Management module allows you to use trades for collateral
management purposes which have been created or processed in a system other than Calypso. Select this menu
option to display the Collateral Exposure Context window.

View Previous Margin Call Credit Ratings
This displays a window that allows you to migrate to the Global Credit Rating configuration, if you have a credit rating
configuration in a previous version.
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Clearing Service Configuration
Eligibility for securities is represented at a clearing service level. With the clearing service configuration, you may have
different eligibility sets for different clearing services for different markets within the same contract.

Liability Group Configuration
Liability groups are collections of liabilities that have been combined together for cover distribution purposes.

2.5 Sett ing up Parent/Chi ld Margin Cal l Contracts
Below is an illustration of how the Parent / Child relationship works with margin call contracts.

The legal entities used in this example are: PO (parent processing org), PO_NY and PO_LA (children) as well as CP
(counterparty).

Step 1 - A parent contract has been created using the two parent legal entities. This contract will define the behavior
of the margin call.

Step 2 - A new contract has been created, this time using the child processing org (PO_NY).

Before adding any details to this contract, select the parent contract from the Parent field.
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The Processing Org is the child PO

A contract was also created with child processing org PO_LA .

After the parent contract is selected, most of the information on the child contract can still be edited and differ from
the parent contract in many ways.

Step 3 - In the Configurations > Child Configurations panel of the parent contract, you are able to view all of the child
contracts of the parent.

Step 4 - If you open the Collateral Manager (Processing > Collateral Management > Collateral Manager) and select
the parent contract Id, you will see that the trades of all of the children organizations are included in the margin call
process.
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2.6 Facade Setup
In some cases, it may be necessary to internally segregate management of certain collateral activities among different
entities. However, this segregation does not need to be viewed on the outside, clients will only deal with one entity,
the facade. The Facade setup allows margins to be allocated at the trading level separately using the Child contracts,
while the exposure is rolled up to the global level using the Facade contract.

» The Facade contract must be designated as Subytype: Facade. If no trading is done on the PO of the Facade
contract, the Eligible Books panel must remain empty.

Facade Margin Call contracts:

• summarize the activity of the child contracts

• hold contract information such as MTA, rounding, etc...

• generated notifications and statements

» The child contracts in a facade setup must have the parent contract input as the Parent.

» In the Eligible Books panel, eligible books must be defined for the contract's allocation.
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Books can be selected for eligible based on belonging to the:

• Contract - Parent LE books (books belonging to the parent (at the LE level) of the PO of the contract)

• Contract - PO books (books belonging to the PO of the contract)

• Parent contract - Parent LE books ( books belonging to the parent (at the LE level) of the PO of the facade
contract)

• Parent contract - PO books (books belonging to the PO of the facade contract)

• Sibling contracts - PO books (books belonging to the PO of the sibling contract)
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» All allocations are done at the child level.

» In Collateral Manager, it is possible to view facade contracts only, child contracts only or both facade and child
contracts using the filter in the Results panel.

2.7 Sett ing Col lateral Dates
You can define rules to determine the settlement dates of the collaterals.

Load a contract and select the Dates & Times panel. In the Collateral Dates area, click  to add a collateral date rule.
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• Select a method: Standard, Alternate, Maturity or Interest.

You can set a standard collateral date (Default – The lag applies to the trade date), an alternate collateral date
(Decided on a trade by trade basis – The lag applies to the trade date) for the same criteria, or a maturity
collateral date (Decided on a trade by trade basis – The lag applies to the maturity date). For example the
standard for USD cash would be 3 days lag, the alternate for USD cash would be 4 days lag.

By default, the standard collateral date will be computed unless the trade keyword CollateralDate is set to
Alternate or Maturity, in which case the alternate collateral date or maturity collateral date will be computed.

The following settings are recommended if you plan to use the Alternate method:

1. Add CollateralDate to the domain tradeKeyword.

2. Create the domain keyword.CollateralDate with values Alternate, Standard, and Maturity.

• Select a currency – You can set different offsets per currency.

• For each collateral category (Cash, or a Security Category, or ANY security category), enter the number of days
between the settlement date and the trade date of the corresponding collateral.

Security categories are specified on the product code CollateralCategory on the collateral definitions. The
available values for the product code CollateralCategory must be defined in the domain
securityCode.CollateralCategory – For example , the collateral categories Corporate and Government could be
defined.

If a USD security has the CollateralCategory set to Corporate, the settlement date will be “trade date + 2 days”, if
the CollateralCategory is not set, the settlement date will be “trade date + 3 days”.

Note that the trade date of the collateral (margin call trade) is the “Process Margin Call for” date of the Margin Call
Manager.

• The Interest method is used to change Settle Dates in bulk. There is no logic behind this method type as it is used
by the Back Office to determine the settle date of Interest trades. It is possible to save more than one Interest
method per contract if the offset is different for different currencies.

For example:

Interest/EUR/1day offset

Interest/USD/2 days offset

Interest/GBP/3 days offset
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2.8 Paying Interest Separately
 Ⓘ When you elect to pay interest separately, the interest will not be computed by the Collateral Manager. The
margin call will populate a specific settlement account, and interest will be computed on this account through
the interest bearing process by generating interest bearing trades

In order for the INTEREST transfer to be taken into account in the Margin Call position, the Margin Call contract Id
needs to be set on the Interest Bearing account attribute MC Contract Id. This can be found in the attribute panel in
the Accounting Definition window (Configuration > Accounting > Accounts).

If the MC Contract Id attribute is not listed, it can be added from Utilities > Add Property Domain. After adding it, click
the to add it to the list of favorites.

Step 1 - In the Eligible Currencies panel, set the following fields: 

» For Cash margins, set the Cash MarginCall Account to true
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» For Security margins, set the Security MarginCall Account flag to true

» Set Orderer Role to Client or Customer. then add that role to the counterparty of the margin call contract.

Then, add that role to the counterparty of the margin call contract.

Step 2 - Create a settlement account for the counterparty’s role defined in ORDERER_ROLE, and associate DDA
settlement instructions.

Sample Settlement Account
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When interest is recapitalized back into the Interest Bearing account, this interest can be used as collateral on the
Margin Call Contract to cover exposures/liabilities.

In order for the INTEREST transfer to be taken into account into the Margin Call position, you need to set the Margin
Call Contract ID on the Interest Bearing account attribute “MC Contract Id”, when you click Properties/Attributes (F4).

If the account is Interest Bearing, and the capitalization frequency is specified, and the “MC Contract Id” attribute is
populated, then the MarginCall transfer attribute is populated on the INTEREST transfer with the Margin Call Contract
ID, and is therefore included in the Margin Call position.

Sample DDA SDIs for the Counterparty with role Client
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Sample DDA SDIs for the ProcessingOrg.
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As a result, the margin call will populate the settlement account. You have then access to all cash management
functions on the settlement account, including the possibility of generating interest bearing trades.

Two transfers are created: one through the agent between the processing org and the counterparty role
Counterparty, and one DDA transfer between the processing org and the counterparty’s role defined in ORDERER_
ROLE. If you want to automatically SETTLE the DDA transfer when the Agent transfer settles, add the transfer
workflow rule "ApplyLinkedDDA" on the transition VERIFIED – SETTLE - SETTLED. It will automatically move the DDA
transfer to SETTLED (You may also set the rule on the transition SETTLED – UNSETTLE – VERIFIED in case you need
to unsettle the agent transfer – It will unsettle the DDA transfer as well).

You need to have the Inventory engine running in order to populate the Margin Call account with the margin calls.The
Inventory position shows a Margin_Call position on the counterparty’s role CounpterParty, a Client position on the
counterparty’s role defined in ORDERER_ROLE (margin call account), an Internal position on the processing org
(margin call account).
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Step 3 - Create interest bearing rules, and associate those with the margin call account - Interest baring trades will be
generated based on those rules.

Sample Interest Bearing Rules

Step 4 - You can generate the interest using the ACCOUNT_INTEREST scheduled task, or by clicking Process Interest
in the Account Definition window, Interests panel.
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In the Entries panel, you can view the position used to compute the interest, and you can perform manual
adjustments.

You can click Pay Interest to transfer the interest to another account – This is the same as running the scheduled task
ACC_TRANSFER_INTEREST. It generates a simple transfer between the accounts, and the account identified by the
legal entity / role selected in the Pay Interest dialog.

If you set the transfer workflow rule ApplyActionLinkedXfer on the transitions VERIFIED – SETTLE – SETTLED and
SETTLED – UNSETTLE – VERIFIED, both the interest payment, and the interest transfer will be settled at the same
time.

Refer to the Calypso Cash Management User Guide for complete information on transferring interest.

2.9 Assigning SDIs when Counterparty 's Agent is the PO
SDI selection for Simple Transfers when the Processing Org is also the Agent of the Counterparty, and intermediaries
are defined on the SDIs.

Please refer to the Calypso Settlements documentation for details.

2.10 Configuring a Haircut
In the Parties panel you may designate a haircut configuration for the margin call contract. This haircut will apply to
the collateral used in the margin call.
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» Select a Haircut Rule you would like to use. If you do not have any rules in place or would like to edit an existing
rule, select Haircut Rule from the Util menu to display the Haircut window.

» Choose the Haircut Type, either Regular [amount • (1 + haircut)] or Inverse [amount /(1 - haircut)]. The haircut
value is not an absolute value. The sign of value is important. Enter a negative value for a discount and a positive
value for a premium.
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» You may choose to exclude the trade level haircut from the exposure calculation.

» The order of definitions in the haircut rule is important. Collateral Manager tries to retrieve a haircut value for a
bond (for example) from the first definition at the top of the list. If that bond is not handled by that definition, the
system tries to handle it in the following definition and so on, until a matching definition is found or the end of the
definition list is reached.

» In addition to security information, the following information is also used to determine which haircut to apply:

– Groups (from the Legal Entity Relation window)

– Country (from the Legal Entity Relation window)

– An additional haircut may be applied in the case of Wrong Way Risk. Wrong Way Risk is possible if the legal
entity pledges a security that is used or is used by a related party (LE Relation). Wrong Way Risk can also
arise if the legal entity country is the same as the country of issuance of the security (Legal Entity Country).
See Haircut documentation for more information.

» A definition using a static data filter rule handles a security or cash if it is accepted by the filter.

» A definition using a quote set rule handles a security (it cannot handle cash) if the quote set has a CLOSE quote
for the security that day.

» The user environment property USE_REVERSE_HAIRCUT affects the display of the haircut values consistently
across the application. If USE_REVERSE_HAIRCUT=false (the default), the haircut intended to discount a value by
5% will be displayed as -5. When USE_REVERSE_HAIRCUT=true, this will instead be displayed as 95 (the
remainder). The same is true for the value input by the user in the configuration. To discount a value by 5%, enter
95 in the haircut configuration when USE_REVERSE_HAIRCUT=true.

» The Termination/Settlement Currency field is a reference currency for cross currency haircut. A haircut will be
applied if the asset being delivered is not in the same currency as one of the designated currencies. This field can
hold one or more currencies and is not mandatory. If there is no designation in this field, the Base Currency field is
used for the cross currency haircut determination.

For information on configuring Haircut rules, refer to the Calypso Trading Environment documentation.

2.11 Modifying a Contract
» Select the Browse panel and click Load to load existing margin call contracts.

You can restrict the results using the search criteria.

Double-click a contract to display its details in the Edit panel, and modify as applicable.

» Click Save to save your changes.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

2.12 Delet ing a Margin Cal l Contract
» Select the Browse panel and click Load to load all existing margin call contracts.
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You can restrict the results using the search criteria.

» Select a contract and click Delete.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

2.13 Displaying Pending Modif icat ions
» Select the Browse panel and click Load to load all existing margin call contracts.

» Then click Show Pending to display any margin call configuration pending authorization. This only applies if the
Authorization mode is enabled.

2.14 Viewing Margin Cal l Contracts
You can view margin call contracts using the Collateral Config report (menu action
reporting.ReportWindow$CollateralConfig) or using the REPORT scheduled task for the CollateralConfig
report type.
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3. Margin Call Credit Rating
In the Calypso Collateral Management module, it is possible to use the Processing Org and the Counterparty credit
rating to determine the Threshold and Minimum Transfer Amount (MTA). The Credit Rating configuration is completed
through the Ratings panel in the Margin Call Contract.

In the Ratings panel, you may also define and designate a Hierarchy which is used to order the agencies and in the
event that there is a missing rating.

» Calypso allows for the Threshold and Minimum Transfer Amounts to be different for the processing org and the
legal entity.

» To effectively use credit ratings in Collateral Manager, you must first set up a Global Rating Configuration. This is
established to allow for comparisons when a legal entity is rated differently by one or more of the applicable rating
agencies. This is used to apply the HIGHER/LOWER Rating selection in the Parties panel of the margin call
contract.

» If no agency is specified in the Eligible Agencies field, any agency is valid to be considered in the ratings. If any
agency is specified in the Eligible Agencies field, all other credit ratings from any non-eligible agencies are
ignored.
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» When the All agencies are mandatory field is selected, all of the agencies designated in the Eligible Agencies field
must provide ratings for the PO and LE (dependent on pricing direction). The default setting on this field is false
(unselected).

3.1 Global Rating Configurat ion
A Global Rating Configuration must be created for comparison purposes between rating agencies. To display this
window from the Margin Call contract:

• Click the Ratings button which displays the Margin Call Credit Rating Configuration window. From the Util menu in
the MC Credit Rating Config window, select Global Rating Configuration.

• In the Margin Call Contract window, select Util > Global Rating Configuration

In this window, you can enter the appropriate rating information.

» Click to add a new row. Select the Agency name and the Seniority. Then click Apply.

» After the row is created, enter the ratings.
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» You may have multiple configurations but only one can be Active. Whichever configuration is flagged as Active is
the one that will be used.

» In each panel, Current or Outlook, you are able to set a configuration. The panel names are called Rating Types.
Additional Rating Types can be defined in the creditRatingType domain value.

» Once the Rating Type is defined in the domain, select Util > Rating Values to add available values for the rating
type if necessary.

» Name the configuration and save it.

» The equivalence table can be different for each rating type depending on the possible credit rating
agency/values for that type.

» Double-click in the Ignored Values column to select ratings values to be ignored for a particular Agency.
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3.2 Conversion to Global Rating
In the Margin Call window, select Util > View Previous Margin Call Credit Ratings to migrate to the Global Credit
Rating configuration. If you choose to convert by Rating Value, you must have set up a Global Rating Equivalence in
the Global Rating Configuration window.

3.3 Margin Cal l Credit Rating Configurat ion
Once you have created and saved a Global Rating Configuration, you are able to enter the desired Threshold and/or
Minimum Transfer Amount data.

» In this window, you may enter a Threshold Amount and / or Minimum Transfer Amount for each priority.

» Name and save your configuration. You may have multiple Margin Call Rating Configurations, selecting whichever
configuration you would like to use for each margin call contract.

» On the Ratings panel in the Margin Call Contract, you must select Eligible Agencies that can be considered for the
contract. Only the agencies selected will be used, regardless of whether they are in the margin call rating
configuration.

» If you enter an amount of 0 in the No Rating row, if a credit rating is missing, the value of the rating will be set to 0
and the contract will be priced. If this amount is left blank and there are missing ratings, the contract will not be
priced and a pricing exception will be generated.

» The IA BOTH field is utilized only when the IA TYPE field for a credit rating is set to BOTH. The options for this field
are:

– Smallest: the system chooses the smallest value between the Amount and the Percentage value calculated

– Biggest: the system chooses the largest value between the Amount and the Percentage value calculated
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This field is the same for the entire configuration. It is not possible to have one column set to Biggest and another
to Smallest within the same configuration. The default value is Biggest.

3.4 Hierarchy
The Ratings Hierarchy window enables the ordering of the Rating Agencies. You may have multiple levels with one or
more agency in each level. You may have multiple Hierarchy configurations. In the Ratings panel of the Margin Call
Contract, designate which hierarchy you would like to use for the PO and LE.

Based on the rating configuration that is selected for either Threshold or MTA in the Parties panel or in the
Independent Amount panel, Calypso looks for the highest or lowest rating of Level 1. If no rating is defined for Level 1,
the system moves on to Level 2 and so on....
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Using the hierarchy set above, let's say that Moody's rating for the Counterparty is Aaa and S&P's rating is AA+. The
Threshold Rating is set to LOWER on the contract. In this case, the S&P rating is used and the Threshold amount is
$450,000.

In another example, let's say that Moody's rating is Aaa and S&P has no rating. Because there is a 0 amount in the
Threshold Amount column for this configuration, the Moody's rating will be used with a Threshold Amount to 500,000.

If on the other hand, we were referring to a MTA instead of a Threshold, because there is nothing entered in the
Minimum Transfer Amount column, Calypso would move on to look at the ratings for the agencies in the next level.
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4. Collateral Context
The collateral architecture does not allow the user to add product specific columns directly into the Collateral or
Clearing Distribution Manager Underlying panel. By default, the Underlying panel only displays information such as
trade date, start date, description, etc... The Collateral Context window takes care of this issue by allowing you to
define additional product properties and pricer measures. This context will be common to every contract.

A Collateral Context is chosen in the Collateral Manager window when loading Margin Call Contracts.

The window is accessible through the Margin Call or Clearing Member Contract window by selecting Util > Collateral
Context or using the following link: refdata.collateral.CollateralContextWindow.

The Collateral Context window looks like that below, with a default set up for Repo trades.

» Enter a name and description for the Collateral Context Configuration.

» Select as many product types and sub-types as you would like to include in the configuration.

» You may add or edit the product properties for each product type.

» Add or edit the pricer measures associated with each product type.

The configurations that are made in the Collateral Context window that apply to column additions are then available
for selection in Collateral Manager or Cover Distribution Manager. To add these columns to the view, select Configure
Columns from the Data menu from the panel of your choice.
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4.1 Posit ion Definit ion
The Position Definition panel allows you to add additional positions to Collateral Manager.

Positions are aggregated by position type. All positions defined in the context are loaded and priced by the collateral
manager. THEORETICAL and ACTUAL positions are always loaded, even if not present in the collateral context.

The Collateral Manager Netted Position panel displays every position defined in the context. By default the Valuation
Position (the position used to calculate the exposure) is always loaded even if not declared in the Collateral Context).

Nasdaq Calypso
Collateral Configuration / Version 18



In the Position Properties area, you may select attributes that will be displayed in the Netted Position panel of
Collateral Manager, such as AccountId, AccountName and AccountType.

4.2 Acadia
This panel is used only for Acadia users.

Refer to Acadia Attributes in Collateral Context in the Acadia documentation for details.

4.3 Currency Definit ion
In this panel, you are able to define a group or groups and a corresponding currency linked to that group. The available
group names are populated from the Collateral.Config.Group domain value.

You may also define a Base Currency, which is used for the remaining margin (base ccy) and base ccy columns. It
enables the comparison of contracts with different contract currencies.

In the Details panel of the margin call contract, you may associate one of these currency definition groups with a
contract.
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4.4 Entry Attr ibutes
The Entry Attribute tab functions in the same way as the Allocation > Allocation Attribute tab. To populate attribute
types, set up a list of available values using the domain MarginCallEntry.NAME_OF_ATTRIBUTE. You may also click

to add the attribute to the appropriate domain.

4.5 Al location
The Allocation panel contains three tabs: Allocation Attributes, Allocation Validator and Settlement Offset.

4.5.1 Al locat ion Att r ibutes
Select the Allocation Attributes tab to define additional attributes for allocation.

Nasdaq Calypso
Collateral Configuration / Version 18



For the Attribute Type: Domain, you can set up the list of available values using the domain
MarginCallAllocation.NAME_OF_ATTRIBUTE.

Attributes already recognized by Calypso are:

• LiabilityGroupName

• LiabilityCurrency

• LiabilityValue

• ContractType

• CoverDistribution

• DistributionType

• CallForCover

• BankGuarantee

• EndDate

• AccomodationChargeId

• TargetAccountId

The attribute can also be displayed in any allocation report (Collateral Manager or Cover Distribution Manager stand
alone report) and the values can be manually edited in the Collateral Allocation window. The attribute is loaded as a
standard column from Configure Columns as described below.

For Cover Distribution, two allocation attributes that can be added in the Collateral Context window, Liability
Configuration and LiabilityName are propagated to the margin call trades (by selecting Propagate to trade) when
"Distribute the call" is selected in the Call Generation section of the Details panel of the contract. The attributes are
visible as trade keywords.

When the TKW to Allocation Attribute flag is selected for an attribute, if a trade keyword name matches the allocation
attribute, then the keyword value can be displayed in the Allocation panel. Select the keyword/attribute name in
Configure Columns.
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Propagation of Attributes to Margin Call Trade
It is possible to propagate certain attributes to the Margin Call trade. These attributes are:

• ExcessCollateral

• NewMargin

• ReturnedMargin

• RemainingMargin

• TotalCollateralValue

• PreviousTotalMargin

• PreviousActualTotalMargin

• ClosingBalance

Additionally, it is possible to propagate attributes from the Margin Call contract Additional Info panel to the Margin Call
trade.

To configure this, first create the domain PropagateToMarginCallAllocation and add the attributes. Attributes from the
Additional Info panel must start with MCC.Attr.xxx.

Then, add the fields to Collateral Context > Allocation Attributes and designate the attributes to propagate to the
trade.
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4.5.2 Al locat ion Val idators
The Allocation Validator panel is used to define validators when allocating and creating margin call trades. The
possible validators are:

• AllocationPriceValidator

• AvailablePositionValidator

• ConcentrationLimitValidator

Please note that concentration limit check is not performed on full return cases when exposure changes are in t
ooohe PO's advantage.

• EligibilityAllocationValidator

• FullAllocationValidator

• IncrementLotSizeValidator

• MinimumPurchaseAmountValidator

• MultiEntryPositionValidator

• SettleDateValidator

• TotalIssuedValidator
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For each validator, it is possible to designate either a hard or soft warning as well as allocation types.

Example:

AvailablePositionValidator
The system compares the allocation nominal against the trading book position nominal coming from the "Allocation_"
Inventory Position template defined in the Allocation window. The user can designate Allocation-Types options of
Margin, Return, and Substitution.

This feature can only be implemented with an Inventory Report Template using a Book Aggregation. Any other
aggregation like Global or Book/Agent/Account will result in a validator failure. The reason why we cannot check at a
more granular level of Book/Agent/Account is because we do not have access to the Agent/Account information until
after the trade is created and SDI selection has occurred.

FullAllocationValidator
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You can check Collateralization_Tolerance to use the tolerance configuration designated in the Collateralization
Tolerance tab.

IncrementLotSizeValidator
In the case of a security allocation, the nominal of each security allocation is compared with the incremental value. If it
is a multiple of the lot size, the validation passes. If it is not a multiple of the lot size, the system recalculates the
allocation based on selected Automatic-Rounding.

Increment Lot Size is specified in Bond product code "Lot Size" by default as defined in domain
Collateral.IncrementLotSize.

In the bond's Product Code Window, input the Lot Size Increment amount. Only if this amount is input for the bond will
the Increment Lot Size Validator work.

MinimumPurchaseAmountValidator
By default, is set to a hard warning.

MultiEntryPositionValidator
A warning appears if the allocations > previous margin of the processing entry + (daily margin) of all the non-selectec
entries. There is also a workflow rule called CheckMultiEntryPosition that performs the same check as this validator.

4.5.3 Sett lement Offset
The Settlement Offset panel allows the ability to override, at the Collateral Context level, the settlement lag
configuration defined in the Margin Call contract.
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When the Override Contract checkbox is enabled, it specifies that the Settlement Offset on the Margin Call contract
should be overridden by the values entered in the Party A and Party B boxes.

4.5.4 Col latera l izat ion Tolerance
A tolerance can be added for a full allocation validation. Therefore, even if a small percentage of the margin is not
allocated or if it is over allocation, the process can continue.

» Enter a Collateralization Tolerance amount.

» When Is Percentage of Net Balance is checked, the collateralization tolerance is calculated based on the Net
Balance.

» Designate to Check Tolerance Against either the Remaining Margin or the Actual Outstanding Margin.

Remaining Margin = Netted Position ─ Return ─ Substitution

This feature can be used in conjunction with Acadia Auto Accept Allocation. Refer to the Acadia documentation for
details.

4.6 Workflow
This panel allows you to link a workflow action directly to the Price and Allocate buttons in Collateral Manager for the
selected margin call contract or to the Load and Load & Process buttons in Cover Distribution Manager.
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4.6.1 Workf low for Col latera l Manager
In Collateral Manager, by default when you click the Price button, you must then apply the NEW workflow action in
order to save the priced contract. You must also perform a save function after an allocation is applied from the
ALLOCATE window.

To allow the save action to be performed automatically after a contract is priced or allocation is applied, use this panel
to set up which action you would like to be performed when these buttons are clicked and all of the criteria is met.

You may also designate a Workflow Subtype and or Workflow Product. The Workflow Actions available for a specified
subtype are displayed based on the actions designated for that subtype in the Collateral Workflow or Cover
Distribution Workflow. The Workflow Products and Workflow Subtypes must also be designated in the Details panel of
the Margin Call or Clearing Member contract.

NOTE: If you would like to hide an action from the Action button drop-down menu or the right-click Action menu in
Collateral Manager, select the Hide Action checkbox.

4.6.2 Workf low Subtype / Workf low Product
The options for Workflow Subtype and Workflow Product are: From Contract, Use Context, From Entry Type and From
Contract and Entry.

The Entry Type designations allow the Processing Type selection in Collateral Manager to determine which workflow
is used.

When From Entry Type is chosen in the Context, the behavior in Collateral Manager is as follows:
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• Processing Type Processing uses workflow subtype processing

• Processing Type Substitution uses workflow subtype substitution

• Processing Type Valuation uses workflow subtype valuation

When From Contract and Entry is chosen, the behavior in Collateral Manager is as follows:

• Processing Type Processing uses the workflow from the Margin Call Contract > Details panel > Workflow field

• Processing Type Substitution uses workflow subtype substitution

• Processing Type Valuation uses workflow subtype valuation

4.6.3 Workf low for Cover Dist r ibut ion Manager
In Cover Distribution Manager, by default when the contracts are loaded no action is applied to the contracts. In other
words, when you Load, Process or Load & Process, none of the figures are saved to the database unless an action is
applied to the contracts. Automatically applying an action upon clicking one of these buttons, is configured in the
Workflow tab of the Collateral Context window.

Below is an example of how a Cover Distribution collateral context can be set up detailing the user action (button or
menu selection) and the workflow action applied depending on the status of the contract at the time.

NOTE: With the above setup, the same action applied to any contract status will result in the same status. This is
useful for the COVER_DISTRIBUTION scheduled task where contracts being processed will most likely be in different
statuses (such as NONE, CALCULATED, PROCESSED or EXECUTED).
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4.6.4 Context Speci f ic Workf low
In the Workflow panel, you may define a context specific workflow which overrides the workflow specified in the
contract for any contracts processed using that context.

An example of when this may be helpful is when a context is being used to calculate the Global Required Margin using
simulated credit ratings. In this case, you would not want to use a standard collateral workflow and would instead
prefer a simplified workflow which moves the contract to a simulated status when using the simulation context.

To use this functionality, follow the steps below.

Step 1 - Add the name of the Context Configuration to either one of the following domain values: CollateralType (for
Subtype), productGroup or productType (for use with different product types).

Step 2 - In the Workflow window (from Calypso Navigator, Configuration > Workflow), specify the workflow to be
used with that context configuration. (If you specified a product type or group, select it from the Product drop-down)

Step 3 - In the Context Configuration window, specify for the Workflow Subtype to use the Context. (If a product type
or group was used instead, select Use Context in the Workflow Product drop-down.) Processing Type may also be
chosen as the Workflow Subtype or Workflow Product. Processing Types are chosen in the Collateral Manager filter
criteria.
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4.7 Pricing
This panel specifies how the collateral data should be priced for the optimization.

4.7 .1 Pr ic ing Envi ronment Type
In this field, designate whether to use end of day (EOD) pricing, intraday (ITD) pricing or credit downgrade simulation
(SIM) during optimization. The pricing environments that correspond to these choices are designated in the Details
panel of the contract.
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4.7 .2 Rat ing Scenar io
The Rating Scenario designation enables simulation of the effects on margin requirements that come from a
downgrade in credit rating or a change to counterparty credit ratings. This functionality can be used solely through
the Collateral module, or perturbed data may be fed into Collateral from the Liquidity module. Selecting a Rating
Scenario in this field indicates that the Collateral module will process data on a scenario basis, rather than a standard
one.

The scenario information comes from the CREDIT_RATING_SCENARIO table. If no scenario is selected, the normal
CREDIT_RATING table is used to process the collateral information. See Margin Call Credit Rating for more information
on standard credit rating processing.

Scenarios are either populated in the CREDIT_RATING_SCENARIO table via the Liquidity module, or the information
can be manually entered in the Collateral module from the Credit Rating Scenario window. This window may displayed
by selecting Util > Credit Rating Scenario.

You may enter rating information pertaining to legal entity and/or product credit ratings as well as designate credit
rating attributes.

NOTE: If the Liquidity module is used to feed credit rating scenario data into the Collateral module, the scenario name
in Liquidity must be entered in the Rating Scenario field of the Collateral Context. This enables Collateral to pull the
appropriate information from the CREDIT_RATING_SCENARIO table. No additional data is required to be entered in the
Credit Rating Scenario window in that case.

Business Case for Credit Rating Scenario
In this example, consider that AB Bank has Senior Secured Debt that is paid first in the event of a default. This debt is
secured by collateral to reduce lending risk. The senior secured loan agreement contains covenants tied to anticipate
financial metrics of the underlying company. These financial covenants are essentially an option to re-price risk when
a covenant default is near or has been reached. If AB Bank projects a certain level of cash flow or leverage (examples
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of the financial covenants) in the future and they fail to deliver, they can come back and ask to negotiate an
amendment to the original agreement, but the new terms often include a re-pricing of risk either in the form of a fee or
higher interest rate.

The current Credit Rating provided to AB Bank from S&P and Moody’s is AAA. Our agreement in place for AB Bank was
based on the ratings. At this credit rating, the threshold established for AB Bank is $2,500,000 USD. The minimum
transfer amount is $500,000 USD. This means in our agreement, we will not initiate a margin call until AB Bank has
reached $500,000 USD exposure over the $2,500,000 USD threshold.

For this example, the credit rating has been downgraded for AB Bank by S&P to AA+. This is still considered a low risk.
However, the second agency, Moody’s, has downgraded AB Bank to Baa1. This represents Medium Risk by Moody’s.
For this agreement, default risk will be managed by using the lowest credit rating (This is set in the Margin Call
Contract.) From the two Credit Rating Agency’s ratings, there could be a possibility that one agency has not received
the most recent rating assignment to reflect the current creditworthiness of AB Bank.

The exposure in this scenario for AB Bank is now $3,000,000 USD. The new threshold exposure based on the current
agreement and previous credit rating by S&P and Moody’s is $1,800,000 USD based on the current threshold of
$2,500,000 USD. The new (MTA) minimum transfer amount exposure based the current agreement and previous
credit rating by S&P and Moody’s is $375,000 USD.

In this scenario, if AB Bank’s credit rating is Baa1 (Medium Risk), the agreement in place is for a threshold of $700,000
USD and the (MTA) minimum transfer amount exposure is $125,000 USD. The exposure is $825,000 USD based on
the downgraded credit rating provided by Moody’s.
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4.7 .3 Valuat ion
This selection designates whether the contracts should be processed for Standard, Ad Hoc or Context Based
valuation.

• Standard Valuation - The pricing is based on the valuation information specified in the Dates & Times panel and
the Minimum Transfer Amount specified in the Parties panel in the contract.

• Ad Hoc Valuation - The pricing is based on the valuation and MTA information specified in the Ad-Hoc Details
panel of the contract.

• Context Based Valuation - When this valuation type is selected, the system ignores the Valuation Date rule and
the Valuation Time Offset rule defined in the Dates & Times panel of the contract and instead loads every contract
(meeting template criteria) on the process date and forces the valuation offset defined on the context. There are
also two fields that appear only when this Valuation Type is chose. One to indicate the Valuation Offset and the
other to designate Business Calendars to use on the context to respect business days for the offset.

4.7 .4 Quote Offset & Exposure Offset
These fields are used to utilize initial margin balances to offset against variation margin. The system will look for a
date rule set, defined in the Dates & Times panel of the Margin Call Contract, and then calculate the real quote the day
after the offset. The exposure value date will be the day after the offset.

Note: Quote Offset exists on the Margin Call contract as well but the setting in the Collateral Context overrides the
contract setting.

Total Quote Offset = Contract Quote Offset Days + Context Quote Offset

Example 1:

Process Date 6/29/2015
Val Date Offset 0
Contract Quote Offset 0
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Context Quote Offset 2 6/25/2015
Total Quote Offset 2 6/25/2015
Exposure Offset 1 6/26/2015

Offset Days FX.GPB.USD Bond T PL Mark
6/21/2015 1.21 91 100021
6/22/2015 1.22 92 100022
6/23/2015 1.23 93 100023

3 6/24/2015 1.24 94 100024
2 6/25/2015 1.25 95 100025
1 6/26/2015 1.26 96 100026
Weekend 6/27/2015 1.27 97 100027
Weekend 6/28/2015 1.28 98 100028
0 6/29/2015 1.29 99 100029

6/30/2015 1.3 100 100030
7/1/2015 1.31 101 100031

Exposure: 100026/1.25 = 80020.80

Example 2:

Process Date 6/29/2015
Val Date Offset 0
Contract Quote Offset 1
Context Quote Offset 2
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Total Quote Offset 3 6/24/2015
Exposure Offset 2 6/25/2015

Offset Days FX.GPB.USD Bond T PL Mark
6/21/2015 1.21 91 100021
6/22/2015 1.22 92 100022
6/23/2015 1.23 93 100023

3 6/24/2015 1.24 94 100024
2 6/25/2015 1.25 95 100025
1 6/26/2015 1.26 96 100026
Weekend 6/27/2015 1.27 97 100027
Weekend 6/28/2015 1.28 98 100028
0 6/29/2015 1.29 99 100029

6/30/2015 1.3 100 100030
7/1/2015 1.31 101 100031

FX rate: 1/1.24 = 0.806452

Exposure: 100025/1.24 = 80665.32

4.7 .5 Col latera l izat ion Status
To simplify the end of day controls on Collateral activity, a collateralization tolerance can be defined, either as a fixed
amount expressed in contract currency or as a percentage based on the Net Balance. This Tolerance definition is then
used in the Collateralization Status in the Collateral Manager Margin Call Entry section.
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• Collateralization Tolerance - A tolerance number in either percentage or contract currency. Decimal values are
permitted.

• Is Percentage? - If false (default), the value provided in Collateralization Tolerance is considered as a fixed
amount expressed in base currency. If true, the value in Collateralization Tolerance is a percentage. The formula is
Tolerance = Collateralization Tolerance * Net Balance / 100.

• Check Tolerance Against - There are two options for this:

– Remaining Margin - For standard business where margin calls need to be covered on a theoretical basis.
When Remaining Margin is chosen, this value is compared against the Tolerance when computing
Collateralization Status in Collateral Manager.

– Actual Outstanding Margin - For Sec Finance, where margin calls need to be covered in real settlement
(considering the collateral settlement status).

4.8 Context Attr ibutes
Some of the attributes of the COLLATERAL_MANAGEMENT scheduled task can be also used for Collateral Manager,
likewise for the attributes of the COVER_DISTRIBUTION scheduled task and Cover Distribution Manager. Having two
separate sets of variables allows for the configuration of scheduled task independently. Some of the attributes are
described below.

Attribute Description

BULK_LOAD_PL_MARKS Set to True for bulk loading of PL Marks. Be sure that the Collateral Exposure product is
using PricerCollateralExposure in the Pricer Configuration.

CREATE_COLLATERAL_ The default of this attribute is true. When set to true, collateral details for repo and sec
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Attribute Description

TRADE lending trades are displayed. Set to false to deactivate this display.

DISPATCHER_NAME Dispatcher configuration name to use for the grid.

MAX_DS_THREAD Limits the maximum number of threads that can query the data server at the same time
in order to avoid too much stress being put on the data server.

POSITION_AGGREGATION_
LEVEL

Position aggregation designation.

Book - Margin Call positions are aggregated based on Book

Global - Margin Call positions are aggregated at the contract level.

If no value is chosen, the default aggregation is by Book.

PRICE_METHOD_AT_
LOADING

This attribute can accept the values PRICE, REPRICE or NONE. The default value is
PRICE if you do not define the attribute. This allows the Collateral Manager to auto-
matically price or re-price the entries as part of the loading process.

RECOMPUTE_FINAL_CALL If this attribute is not set or set to True (default behavior) then there is no change in
final call amount behavior. If it is set to False, then the Final Call Amount is not
recomputed when executing the distribution.

When the Final Call Amount is reset to 0, the Remaining Margin will always be equal to
the Call including the buffer.

When the Final Call Amount is not reset, the Remaining Margin = Call including buffer –
Final Amount.

THREAD_POOL_SIZE Total number of threads used by the Collateral module for improved performance

USE_GRID_CALCULATOR Set to true if the collateral module should run using the grid calculator
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5. Collateral Exposure
The Collateral Management module allows you to use trades for collateral management purposes which have been
created outside of the Calypso system, and are imported into the Calypso system as Collateral Exposure trades.
Margin calls can be computed on those trades as on any other native Calypso trade.

This applies, for example, to initial margins imported from the clearing houses in the context of OTC Clearing.

5.1 Col lateral Exposure Context
The Collateral Exposure Context window allows you to define the structure of the underlying product of the Collateral
Exposure trade. You may save as many contexts was you wish, but only one context may be selected at the default
and that context is the one used by the system.

To view this window, select Util > Collateral Exposure Context from the Margin Call Contract window or the Clearing
Member Contract window.

» Enter a Name and Description for your exposure context. Select the default check box to indicate if you would like
the context to be the default and therefore the one the system automatically uses.

» Click to add a product type or underlying. These are defined in the domain value
CollateralExposure.subtype.
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» In the Product Properties area, click to add properties to define your underlying product. When you click this
button, the Collateral Exposure Property window displays.

Fields Description

Name The name of the property

Property Type Select the type of data for the property (String, Date, etc...)

Property
Category

Enter a category for the property. This is used to group the properties in the Collateral Exposure
Trade window.

Description Enter a brief description for the property.

Mandatory Check this box if the property is required to save a trade.

» The Description Pattern is used to generate the trade description. The keyword with the format NAME_OF_
PROPERTY will be replaced by the value. Below is an example.

A saved collateral exposure trade with the above description:
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» The Attributes tab allows you to add additional information to a context. The list of attributes is defined by the
domain value CollateralExposureContext. The list of possible values for an attribute is defined with the

CollateralExposureContext.NAME_OF_THE_ATTRIBUTE domain value. You may also click to add the attribute
to the domain.

5.2 Col lateral Exposure Trades
A Collateral Exposure trade displays the trade using basic trade information (such as start date, end date, currency,
etc...) but it also contains additional product information defined in the Collateral Exposure Context.

You can add the Collateral Exposure Trade window through the Main Entry Customizer (Utilities > Main Entry
Customizer)

Menu action: trading.TradeCollateralExposureWindow

Once opened, the Collateral Exposure Trade window looks like that below.
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For these types of trades, the product family and type is Collateral Exposure. the product subtype is the underlying
type. This is defined in the Contract.
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You are able to display the product properties of a Collateral Exposure trade in a trade report like any other product.
See the Configure Columns window in the Trade Browser below. (Deal Management > Trade Browser)

Below is an example of how a Collateral Exposure trade appears in the Collateral Manager.
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NOTE: When using a PL Mark currency, you must use the PricerCollateralExposure pricer.
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6. Exposure Groups
To meet IOSCO regulations, specifically the 2-way movement of Initial Margin and the Variation Margin currency silos,
Calypso has a solution which breaks down contract level exposures into more granular Exposure Groups. This works
by defining filters which consolidate underlying trades for a contract into distinct exposure groups or portfolios. These
groups maintain their own exposures and their own previous collateral positions. The sum of the groups' exposures
and the sum of the groups' positions form the required margin to the external counterparty.

There are two solutions that comprise the Exposure Group Functionality. One solution involves independent
workflows for the exposure groups called Bilateral Exposure Group Functionality and the other involves the exposure
groups exchanging cash or securities internally and depending on the parent contract for the workflow. This is called
Buy Side Fund Distribution.

6.1 Bi lateral Exposure Groups
The IOSCO framework mandates that Initial Margin be exchanged on a 2-way basis. This means that each party must
exchange their portion of the Initial Margin requirement. The IOSCO framework also mandates that the Variation
Margin be subject to Currency Silos. Currency Silos require that exposures be covered in their own currency, or a
specific currency. For example, if a contract accepts EUR and USD transactions, the EUR exposure can be covered
only with EUR collateral and the USD exposure can only be covered with USD collateral.

Using Bilateral Exposure Groups:

• It is possible to create a single Initial Margin contract which has two underlying Exposure Groups. One Exposure
Group represents the exposures/collateral that the PO has to pledge to the CP. The other Exposure Group
represents the exposures/collateral the CP has to pledge to the PO.

• It is possible to create a singe Variation Margin contract which has multiple underlying Exposure Groups. Each
Exposure group can accept trades of a certain currency (or multiple currencies for the Group Currency silo). Each
Exposure Group would have its own eligibility set and its own haircut schedule to apply to appropriate cross
currency haircuts.

With Exposure Groups, each group can have its own Minimum Transfer Amount, Threshold and rounding convention.
Each group can maintain its own workflow for payment and dispute purposes. This means that each group's
workflows do not have to be synchronized together. For example, one Exposure Group can be in PRICED_PAY status
while another is in EXPOSURE_AGREED status.

6.1 .1 Contract Creat ion with Bi la tera l Exposure Groups
When designating a contract to use Exposure Groups , it is necessary to have Generate Margin Calls per Exposure
Group selected in the Details panel of the contract. This field is selected by default in a margin call contract.
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» If this field is selected and there are NO Exposure Groups on the contract, Margin Calls will be generated at the
contract level.

» If this field is selected, and there ARE Exposure Groups on the contract, Margin Calls are generated at the
Exposure Group level. Workflow actions can be applied at the master contract level as well as the Exposure Group
level.
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6.1 .2 Bi la tera l Exposure Groups
Select the Exposure Groups panel of the margin call contract.

» A currency is required to save an Exposure Group but a Filter is not. If a filter is not defined, all underlyings that
belong to the main contract will be loaded at the Exposure Group level.

» Exposure Groups use a static data filter to determine which exposure trades will belong to the Exposure Group.
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» After the margin call contract is saved with the Exposure Group, an Id is assigned to the Exposure Groups.

» It is possible to Duplicate an existing Exposure Group, delete a single group or delete all of the groups using the
icons at the top of the Exposure Group panel.

» Each Exposure Group can have its own settings for Parties, Eligibility, Concentration & Limits , Triparty Details ,
Acadia Details and Attributes (Additional Information). At this time, if fields in the Exposure Group are not set,
Calypso does NOT take the settings from the main contract.

» The Enable Allocation Process flag is available for selection when Distribute To Exposure Group on the Details
panel has been selected. This flag indicates that the Exposure Group will be available for the Allocation
Distribution process.

6.1 .3 Comput ing a Marg in Cal l wi th Bi la tera l Exposure Groups
The process of computing a margin call with Bilateral Exposure Groups is the same as computing a margin call without
Exposure Groups. Although margin calls are generated at the Exposure Group level the process of optimization,
allocation, disputes, etc..., are the same as if the margin call was at the contract level.

Please refer to Calypso Collateral Management documentation for details on computing margin calls.
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6.2 Buy Side Fund Distr ibution
In this solution, once individual exposure trades are sorted into the Exposure Groups, pricing the contract computes
the Required Margin for the contract. A margin call is generated in a collateral book against an external counterparty
based on the sum of the Exposure Group information. Calypso then computes each Exposure Group's ratio relative to
the sum for the groups. It is possible to have this ratio computed based on information such as required margin, trade
exposures or change in trade exposures. The metric used to determine the ratio is defined in the Collateral Context.
The ratio is then used to allocate from or to each relevant Exposure Group book and Exposure Group position
(Exposure Groups can also be considered Portfolios.)

Below is a basic set up example. Specifics can vary by client.

6.2 .1 Book Designat ion
There needs to be designated books for the Margin Call position itself, as well as the Margin Call Exposure and the
each of the Exposure Groups. It is helpful to use a similar naming convention to quickly identify the books. In the
example below, the books are named as follows:

• Margin Call Positions book: BuySide_MrgCall_Bk001
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• Exposures: BuySide_Exposure_Bk001

• Portfolio Books: 

BuySide_ExpGrp_Bk001A

BuySide_ExpGrp_Bk001B

BuySide_ExpGrp_Bk001C

The Book window is accessed from Calypso Navigator by selecting Configuration > Books & Bundles > Trading
Book.

6.2 .2 Contract Creat ion with Buy Side Exposure Groups
Create a Margin Call contract that will serve as a Buy Side contract. In this example, three Exposure Groups have been
created. This contract looks at the exposure book (specified above) to get the exposure.
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» In the Details panel of the Buy Side margin call contract, Distribute to Exposure Group must be selected. In order
for this option to be displayed, de-select Generate Margin Calls per Exposure Group. This action displays
Distribute to Exposure Group, which you are then able to select.

» When the Portfolio Based Distribution flag is selected, collateral is provided by the Exposure Groups rather than
the PO's collateral being distributed to the Exposure Groups.

» When Portfolio Based Inclusion is selected, a Direction Based Inclusion flag becomes available for selection.
When this flag is selected, if the net exposure of the Exposure Group is not in the same direction as the Master
contract, it will be excluded from the distribution process.
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6.2 .3 Exposure Groups
Exposure Groups use a static data filter to determine which exposure trades will belong to the Exposure Group. In this
example, three Exposure Groups will be set up. One for USD, one for EUR and one for GBP. Below is an example of the
static data filter that has been set up to be used by each of the Exposure Groups.

Exposure Groups are created in the Exposure Groups panel of the margin call contract.

» In the Details panel of the Exposure Group, select the currency for the group and the static data filter to be used
for the group.
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» Collateral Distribution MTA and Collateral Distribution MTA Currency appear in the contract when
DefaultCollateralDistributionMTA is added to the domain values in domainName.

When defining the domain value, the MTA amount should be input in the Value field and the currency for the MTA
should be input in the Comment field.

» In the Parties panel, the selection of a Processing Org is used to drive the counterparty on the Clearing
Distribution trade. Also, for reporting purposes, it is used to load the Allocation Entry report to retrieve all Exposure
Groups for a given portfolio.

» Eligible Books for the Exposure Group correspond to each portfolio.

» In this example, Portfolio A is eligible to provide USD, EUR and GBP cash as collateral. This designation is made in
the Eligible Currencies panel of each Exposure Group.
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6.2 .4 Execut ing a Buy Side Exposure Group Al locat ion
Once individual trades are sorted into Exposure Groups based on the criteria of the contract and group, pricing the
contract computes the Required Margin for the contract.

In the example below, the contract created above has been loaded. For the sake of simplicity and ease of illustration,
three trades are in the contract, one in each of the exposure group currencies. Each trade will be sorted into its
appropriate Exposure Group.
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When a margin call is generated on the contract, normal Collateral procedure is followed for allocation.

6.2 .5 Comput ing a Rat io
After this takes place, Calypso needs to compute each Exposure Group's ratio relative to the sum for the groups. It is
possible to compute this ratio based on any of a variety of factors such as the required margin, the trade exposures or
the change in trade exposures. The ratio is computed as:

(the chosen metric for the Exposure Group) / (the sum of the chosen metrics for all of the participating Exposure
Groups)

Before the ratio can be generated, a collateral context needs to be set up to use the desired metric.
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The Ratio calculation metric is selected in the Exposure Ratio Base field which is contained in the Pricing panel of the
Collateral Context window. The options available for selection include pricer measures selected in the Product
Definition panel as well as values available in the Margin Call Entry column chooser in Collateral Manager.

Once the Ratio metric has been added, the Exposure Group Ratio column can be added to show the ratio for each
Exposure Group.
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In this example, Global Required Margin is used as the ratio metric. To determine the ratio, the Global Required Margin
of each Exposure Group is divided by the Global Required Margin of the participating Exposure Groups to determine
the ratio of each group.

(For example for PortfolioA, -50 /-100 = .5)

If an Exposure Group has not been designated to be used in the allocation process, it will not have a ratio and the
allocation ratio will be distributed among the other Exposure Groups.

6.2 .6 Comput ing Marg in Cal l
The next step is to generate a Margin Call trade and then generate the Clearing Distribution trades to distribute the
positions to or from the Exposure Groups.

In the current example, the Inventory Position report for the parent and children has no position yet.

Now, the Margin Call trade has been booked:
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The Inventory Position Report now contains information:

» When there is a Dispute, the Exposure Group Global Required Margin is recomputed because the margin to pay
has changed. This occurs specifically, when entering a value in the Cpty Amount field and clicking the Accept CP
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Amount or when entering an Agreed Amount. A user is required to apply an action to the entry after accepting the
Counterparty amount. Once this action is applied, it is necessary to reprice the contract in order to re-compute
the Exposure Group GRM values.

6.2 .7 Generat ing an Al locat ion Dist r ibut ion

Optimizing the Contract
After the Margin Call trade is booked, the contract can be optimized for allocation distribution from or to the Exposure
Groups. A specific Optimization Configuration must be set up for this purpose.

» The Optimization Type must be AllocationDistribution.

» There are three solvers with this Optimization Type, Money-Value is used for cash margin call trades, Collateral-
Quantity is used for allocation of security margin call trades and Targeted-Allocation can be used for either cash
or securities.

– The Money-Value solver retrieves the ratios per participating Exposure Group and multiplies each
participating Exposure Group's signed ratio by the signed value of the margin call trade. It then creates a
Clearing Distribution trade, moving collateral between the Exposure Group contract/book and the parent
contract/book.

– The Collateral-Quantity solver retrieves the total previous collateral quantity and the booked allocation
quantity across all participating Exposure Groups and sums these values to come up with the total collateral
quantity. The solver then multiplies each participating Exposure Group's signed ratio by the signed total
collateral quantity to determine each participating Exposure Group's portion of the total collateral. The
solver then subtracts this amount from the total previous collateral quantity for each participating Exposure

Nasdaq Calypso
Collateral Configuration / Version 18



Group to determine each Exposure Group's excess or deficit. The solver then uses this number as the
quantity for each Clearing Distribution trade which moves the collateral between the Exposure Group
contract/book and the parent contract/book.

– The Targeted-Allocation solver facilitates the distribution of collateral from the Exposure Groups to the
mater contract. This differs from the other two solvers which distribute collateral from the master contract
to the underlying Exposure Groups. This solver is used in conjunction with the Portfolio Based Distribution
flag that is set in the Details panel of the Margin Call contract.

The Margin-Filter constraint is the only constraint available and should be used with this optimizer. This constraint is
used to determine which margin call trades will be distributed by this optimizer.

A static data filter is used to choose the appropriate margin call trades for the optimizer. At minimum, the static data
filter needs two attributes

Product Type=MarginCall and Product Sub Type=MarginCall.XXXX.
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Because the Money-Value Solver only deals correctly with cash margin call trades, the Product Sub Type used in a
static data filter designed for the Money-Value solver should be MarginCall.COLLATERAL. Likewise, because the
Collateral-Quantity solver only deals correctly with security margin call trades, the Product Sub Type that used with a
static data filter designed for the Collateral-Quantity solver should be MarginCall.SECURITY.

After optimizing the contract using the optimizer configured above, a trade is generated for the Exposure Group
PortfolioA contract.
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NOTE: It is not possible to perform a manual allocation for the allocation distribution. The allocation must be done
using a properly configured optimizer.

When delivering collateral for pools with a negative net balance, Net Exposure = Net Balance (negative value) +
Previous Margin (positive value) + Newly Allocated Margin (additional positive value). The pools with the largest
negative net exposures will receive back incremental collateral so that their resulting net exposures are less and less
negative.

A domain value is used to control how much collateral is allocated at each step of the new algorithm. The amount
desired should be entered in the ExposureGroupGrmComputationIncreaseAmount domain value. When this is not set,
the default value of 1000 is used.

Distribution Workflow
The actual Clearing Distribution trades are not generated until the DISTRIBUTE workflow action is executed on the
contract. The DISTRIBUTE action may need to be added to the CollateralAction domain value and the DISTRIBUTED
trade status may need to be added to the CollateralStatus domain value. The workflow also needs to use the
Distribute workflow rule on the EXECUTED - DISTRIBUTE - DISTRIBUTED transition (Configuration > System >
Domain Values).

Nasdaq Calypso
Collateral Configuration / Version 18

April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 134 / 170



April 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 135 / 170

6.2 .8 Clear ing Dist r ibut ion Trade
After the DISTRIBUTE workflow action is executed, a Clearing Distribution trade is created between the parent
contract and its Exposure Group.

In the trade created above, you can see that the Source Contract is always the parent contract and the Destination
Contract is always the Exposure Group contract. This is the case regardless of who is paying and receiving. In our
example, the parent contract received and the Exposure Group paid. This is because the Exposure Group lost money
and therefore needs to pay the parent.
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Trade Attributes for the Clearing Distribution trade.

Now, the Inventory Position shows that the Parent Contract is even and the Exposure Group contracts have paid the
Parent.
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» It is possible to differentiate whether the Distribution Direction is a margin or a return from the Exposure Group’s
perspective. Using the bookingType field, which reflects the parent margin call trade direction, and whether the
Exposure Group is paying or receiving, the value of the Distribution Direction is computed as follows:

– Distribution Direction = RETURN if the PO is paying by either delivering new collateral or the PO is returning
previous CP collateral back to the CP and the Exposure Group is receiving

– Distribution Direction = MARGIN if the PO is paying by either delivering new collateral or the PO is returning
previous CP collateral back to the CP and the Exposure Group is paying

– Distribution Direction = RETURN if the PO is receiving by either the CP delivering new collateral or the CP
returning previous PO collateral back to the PO and the Exposure Group is paying

– Distribution Direction = MARGIN if the PO is receiving by either delivering new collateral or the CP is
returning previous PO collateral back to the PO and the Exposure Group is receiving

Distribution Direction refers to the distribution of the Exposure Group. It needs to be added in the tradeKeyword
domain value and to the allocation attributes in the Allocation panel of Collateral Manager.

» A Clearing Distribution trade can generate a corresponding client transfer so that interest can be computed at the
Exposure Group level. A keyword is set on the Collateral Distribution trade if the Cash Margin Call Account flag is
enabled in the Eligible Currencies panel of the Margin Call contract. This indicates that a client transfer is needed.
The keyword is called Generate Client Transfer and is set to True.

» It is possible to set different flow types on Clearing Distribution trades via a domain value called
ClearingDistribution.flow.Type. There is one out-of-the-box value which is Collateral.
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6.3 Col lateral Distr ibution via Scheduled Task
Collateral Distribution can be preformed via the COLLATERAL_MANAGEMENT scheduled task. Simply choose the buy
side optimization configuration in the Attributes section.
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7. Collateral Pool
A collateral pool is a group of assets to which a user has access when executing an allocation, either automatic or
manual. A collateral pool definition is used to create a collateral pool instance. A collateral pool instance is a list of
assets, quantities and attributes (collateral positions). A collateral pool definition is defined by:

• an identifier (id/version/name/description)

• a set of collateral sources

• a pricing environment

The Collateral Pool functionality consists of three main components: a Source, a Connector and the pool itself.

The connector is responsible for importing assets to a source. A Source is a list of Connectors and as well as a set of
rules to provide a set of securities as output. For example, the securities can come from a CSV file if they are managed
outside of the Calypso system, or from the inventory if they are managed within Calypso. You are free to define your
own connectors. The Pool consists of the securities available in the different sources that are selected.

The Collateral Pool functionality is part of the Collateral Module.
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7.1 Col lateral Pool Setup
Below are the steps necessary to configure a collateral pool.

Step 1 - A source must first be created. To open the Collateral Source configuration window, from Collateral Manager,
select Window > Configuration > Collateral Source from Collateral Manager.

Select a Source Type.

Step 2 - Define a Connector for the source. Choose from your defined connectors. Connector choices vary depending
on selected Source Type.
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Step 3 - You may then define constraints that apply to all of the securities of this source. The definition of constraints
is not mandatory.

Additional constraints can be defined in the Collateral.Pool.Constraint domain value.

Step 4 - Collateral Cost modifies the optimization cost. It tells the optimizer the extra cost of the collateral. You must
define how to configure this extra cost for each source using a static data filter.

This is also not mandatory.

The options for selection are Cash, Security or Source. The Source option allows any asset within the source to share
a single cost, as well as allowing individual additional costs on assets within the Collateral Source.
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Step 5 - Once the source information has been created, the pool can be defined. From Collateral Manager, select
Window > Configuration > Collateral Pool.

In the Source panel, you are able to select from the sources defined previously.

Step 6 - In the Position Preview panel, select pricer configuration details for the pool and preview the pool positions.
From this panel, you are also able to price the positions, check market data, add, remove or edit positions. Attributes
that pertain to the pool can be specified in the Attributes panel. The

You may create as many collateral pools as you wish.

Step 7 - Replace the Inventory constraint from your Optimization Configuration with a Collateral-Pool constraint.
Select Windows > Configuration > Optimization Configuration to display the Optimization Configuration window.
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7.2 Col lateral Source Configurat ion Window
The Collateral Source Configuration window contains a source Type field as well as five panels, which are described
below.

7.2 .1 Source Type
The Type field is used to designate the source type to be used. The available options are:

• Fund Ownership - This source analyzes the Fund Ownership Table which contains information about each Fund’s
ownership in other funds. It will determine, for a given fund, which funds it has an ownership in and will populate
the source with a percentage of each asset within those funds. When a fund utilizes assets from another fund, the
system tracks the initial, used and available quantities of these assets.

The Ownership Connector defined on this source allows the user to define how many levels to “look-through” to
determine if a fund only has access to funds in which it has a direct ownership, or whether it should also look-
through to sub funds. For example, if Fund 1 owns 10% of Fund 2 and Fund 2 owns 50% of fund 3, then Fund 1 can,
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in theory, have access to 5% of Fund 3’s assets. Define 1 level to only look at Fund 2’s assets. Define 2 levels to
also look at Fund 3’s assets.

The Ownership Table used in the Connector for this source references the Ownership Ratio that is defined in the
Fund window. Refer to Asset Management documentation for details on this window.

This is a dynamic Source Type, which means that this source needs to be defined only once in the system. When
this source is added to a Collateral Pool, the system will determine the available assets for this source by fetching
the assets for the Legal Entity tied to the Collateral Pool.

• Rehypothecatable Assets – This source looks for contracts which have received rehypothecatable assets. It then
looks at underlying funds which have computed a Rehypothecation Ratio on these contracts and will determine
how much of that rehypothecatable collateral is available for a given fund to pledge towards other obligations on
other contracts.

This is a dynamic Source Type, which means that this source needs to be defined only once in the system. When
this source is added to a Collateral Pool, the system will determine the available assets for this source by fetching
the assets for the Legal Entity tied to the Collateral Pool.

When using this source, to view the breakdown of netted Margin Call positions, the domain value
breakdownNettedMarginCallPositions must be set to True. Note: This is a useful view for other sources as well.

• Own Assets – This source is an inventory of one or more trading book positions.

This is a dynamic Source Type, which means that this source needs to be defined only once in the system. When
this source is added to a Collateral Pool, the system will determine the available assets for this source by fetching
the assets for the Legal Entity tied to the Collateral Pool.

• Other

• External Assets

7.2 .2 Connectors

A connector is responsible for importing assets to a source. Click to configure a connector. The available
connectors vary depending on the Source Type selected.

Own Asset Connector
This connector is used with the Own Assets Source Type.
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Field Description

NAME Enter a name for the connector

Position
Class

Position class filter will always be Internal

Position Type This can be any position defined in the Inventory Position such as Actual, Not Settled, Theoretical,
etc...

Date Type Date type used for the positions in this connector. Available, Booking, Settle or Trade Date

Movements This will always be Collateral Usable

Connector Ownership Table
This connector is used with the Fund Ownership Source Type.
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Field Description

NAME Enter a name for the connector

Position
Class

Position class filter will always be Internal

Position
Type

This can be any position defined in the Inventory Position such as Actual, Not Settled, Theoretical, etc...

Date Type Date type used for the positions in this connector. Available, Booking, Settle or Trade Date

Movement This will always be Collateral Usable

Look-
Through
Level

Specify the number of levels to "look through" to determine if a fund only has access to funds in which it
has a direct ownership or whether it should also look through to sub funds.

For example, if Fund 1 owns 10% of Fund 2 and Fund 2 owns 50% of fund 3, then Fund 1 can, in theory,
have access to 5% of Fund 3's assets. Define 1 level to only look at Fund 2's assets. Define 2 levels to
also look at Fund 3's assets.

Connector Rhypothecable
This connector is used with the Rhypothecable Assets Source Type.
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Field Description

NAME Enter a name for the connector

Position
Class

Position class filter will always be Margin_Call

Position Type This can be any position defined in the Inventory Position such as Actual, Not Settled, Theoretical,
etc...

Date Type Date type used for the positions in this connector. Available, Booking, Settle or Trade Date

Master Books Select

Books

Movement This will always be Collateral Margin Call Rehypothecable

Inventory & CSV Connectors
The Inventory and CSV connectors are used with both the External Assets and Other Source Types.
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Field Description

Name Enter a name for the CSV connector

File Select the name of the CSV file

Example of CSV file:

7.2 .3 Constra ints
This panel allows you to define constraints that apply to the securities of this source. The designation of constraints is
not mandatory.

Constraint Description

Coupon Do not use a position if a coupon payment is to occur in the next 'x' number of days.
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Constraint Description

Date Type: select Coupon Date or Record Date

Days: If a coupon payment is to occur under the designated number of days, the security is not
used as part of the collateral source. These are business days, using the security holiday calendar.

Dividend Do not use a position if a dividend payment is to occur in the next 'x' number of days.

Date Type: Date type description, Coupon Date or Record Date

Days: If a dividend payment is to occur under the designated number of days, the security is not
used as part of the collateral source. These are business days, using the security holiday calendar.

MaximumUsage This limits a position usage to a designated maximum percentage.

SDFilter Do not use a position if a security belongs to a designated static data filter.

Filter: Select the desired static data filter
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Constraint Description

Start date: Exclude positions if a security matches a static data filter after the start date. The start
date is compared against the value date of the margin call entry.

End date: Exclude positions if a security matches a static data filter before the end date. The end
date is compared against the value date of the margin call entry.

Volatility Exclude a security when the volatility is lower than the minimum authorized, based on the
security's holiday calendar.

Enter the minimum number of days needed between the value date and the end date of the
security.

7.2 .4 Col latera l Cost
This panel allows you to specify an extra optimization cost for the collateral issued by this source. The Source option
allows any asset within the source to share a single cost, as well as allowing individual additional costs on assets
within the Collateral Source.

The collateral source will provide what is the extra optimization cost for the collateral issued by this source.

The cost will be defined by several methodologies:

• Percentage (add 2% to the collateral cost)

• Add (add x basis point to the collateral cost)

• Override (set the collateral cost to x)

• No Modification

The collateral cost will be defined by security category

7.2 .5 Att r ibutes
Attributes are information that you can put on your pool or on your sources, such as a custom rule. They are not used
by Calypso, but they may be used in client custom code.
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7.2 .6 Posi t ions Prev iew
This panel provides a preview of the positions which are included in this source as well as the ability to configure the
display of this information.

7.3 Col lateral Pool Configurat ion Window
Below is a description of the panels in the Collateral Pool Configuration window.

Enter the Name and Description of the Collateral Pool. The Legal Entity designation is used when allocating collateral,
indicating which Collateral Pool to fetch when allocating to an Exposure Group.
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7.3 .1 Sources
From this panel, you are able to select the source or sources for the Collateral Pool. You are also able to select a

source and click the edit button to display the Source Configuration window and directly edit the source.

7.3 .2 Pos i t ion Prev iew
This panel allows you to display a preview of the positions which are included in this Collateral Pool as well as
configure the display of this information.
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7.3 .3 Att r ibutes
Attributes are information that you can put on your pool or on your sources, such as a custom rule. They are not used
by Calypso, but they may be used in client custom code.
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8. Concentration & Limits
Concentration risk arises when significant amounts of the same securities are taken as collateral with the unintended
effect that the institution finds itself relying on that collateral too much. Concentration risk can also arise with sectors,
currencies, maturities and even with custodians, if too much collateral is being held in one location.

In order to reduce this risk, Concentration Limits are defined. They are meant to protect against the effect of a
collapse in the instrument's price and avoid a prolonged sale of the collateral. Collateral concentration limit is the limit
of collateral, in nominal amount and /or percentage, that can be provided according to a set of parameters. Defining
concentration limits enables the reduction of risk by limiting the exposure to a particular issuer, for example.
Concentration limits can also be applied to currencies, security ratings, countries or other criteria.

Below is a description of what concentration limits are and how they work within the Calypso Collateral Management
module.

The following set up requirements are needed to use the concentration limit functionality:

• Static Data Filters

• Concentration Rules

• Margin Call / Clearing Member Contract

8.1 Stat ic Data Fi l ter Setup
You must define static data filters that cover all of the eligible security collateral. The Static Data Filter window is
accessed through Configuration > Filters > Static Data Filter.

The number of filters that are set up vary depending upon your concentration limits. Below is an example of one static
data filter used in the examples, a filter that covers all product type bonds with currency type of EUR.

8.2 Concentrat ion Rules
The Concentration Rule Configuration window is available through Configuration > Fees, Haircut and Margin Calls >
Margin Call Concentration. If this window is unavailable in this menu, you may add it through the Main Entry
Customizer ( Utilities > Main Entry Customizer) refdata.concentration.ConcentrationRuleWindow
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A concentration rule is a group of concentration limits. In Calypso, you can define three types of concentration limit: 

• Category - defines how much or how little (in percentage or value) of a certain category is allowed in the
allocation. The calculation is based on the "Total Collateral" Value.

Limit % = Category Collateral Value / Total Collateral Value

• Issuer - defines how much, in percentages, of the allocation can come from the same issuer. The calculation is
based on the Category Collateral Value.

• Issue - defines how much, in percentages, of a same issuance (bond or equity) can be sued for the collateral
allocation. The calculation is based on the product definition.

Each concentration rule has a type (Category, Issue and Issuer). It is not possible to have different types in the same
concentration rule.

8.2 .1 Concentrat ion L imi ts

Click to add a new limit rule.
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The fields and configuration options of the Concentration Limit Rule window are described below.

Fields Description

Scope
Underlying
Type

The Underlying Type can be either Cash or Security

Static Data
Filter

If Security is selected as the Underlying Type, select the static data filter to be used for the rule

List of
currencies

If Cash is selected as the Underlying Type, select the currencies to be included in the rule

Calculation
Breakdown Specify how the calculation should be broken down, whether by issuer Country, Issuer, Ultimate Issuer

(Issuer Group), Security, Product Code or have no breakdown at all.

Collateral
Value

Option to compute the concentration limit using the pre-haircut or the post-haircut value (in contract
currency) of each collateral asset allocated on the contract that is eligible for the concentration limit
rule.

Percentage
Basis

Choose from Total Collateral Value, Category Collateral Value, Total Issued, Net Asset Value, Margin
Required or Average Daily Trading Volume (available only when Breakdown is Security).

See Percentage Basis Calculations below for a description of how Percentage Basis is calculated.
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Fields Description

Limit
Minimum
(%)

The minimum for the concentration ratio, percentage under which it will not be accepted.

Minimum
(Value)

The minimum amount the concentration limit can be in value. It is the value under which the limit will
not be accepted.

This is applicable for the Category rule type only.

Maximum
(%)

The maximum for the concentration ratio. It is the percentage over which it will not be accepted.

Maximum
(Value)

The maximum amount the concentration limit can be in value. It is the value over which the limit will not
be accepted.

To add a concentration limit row, click the to display the Concentration Limit window.

Cash concentration limits are considered when using the Allocation-Rule solver with concentration and/or
substitution rule set. The Concentration Limit should be set with No Breakdown, Collateral Value = Pre-Haircut Value
and Percentage Basis can be either Net Exposure Value or Category Collateral Value with the maximum based on a
percentage or fixed value.

8.2 .2 Percentage Basis Calcu lat ions

Category Collateral Value
This Percentage Basis is NOT required to meet regulatory requirements.

• Breakdown by Issuer - Usage (%) = Collateral Value of asset issued by the same issuer / Category Collateral Value

Collateral Value of asset issued by the same issuer is the dirty post-haircut value (Contract Value) of all assets
held by the Margin Call contract and issued by the same issuer.

Category Collateral Value is the dirty post-haircut value (Contract Value) of all assets eligible for the specified
static data filter.

• Breakdown by Country - Usage (%) = Collateral Value of collateral asset issued by issuers from the same country /
Category Collateral Value

Collateral Value of asset issued by issuers from the same country is the dirty post-haircut value (Contract Value)
of all assets held by the Margin Call contract and issued by issuers from the same country.

Category Collateral Value is the dirty post-haircut value (Contract Value) of all assets held by the Margin Call
contract and eligible for the specified static data filter.

The collateral assets must be grouped by Issuers domiciled in the same country and be determined by the
Country field in the product definition.
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• Breakdown by Ultimate Issuer - Usage (%) = Collateral Value of the collateral asset issued by an ultimate issuer /
Category Collateral Value

The ultimate issuer is based on the product code ULTIMATE_ISSUER_ID.

Collateral Value of the collateral asset issued by an ultimate issuer is the dirty post-haircut value (Contract Value)
of all assets held by the Margin Call contract and eligible for the specified static data filter.

Category Collateral Value is the dirty post-haircut value (Contract Value) of all assets held by the Margin Call
contract and eligible for the specified static data filter.

Total Collateral Value
This Percentage Basis IS required to meet regulatory requirements.

• Breakdown by Issuer - Usage (%) = Collateral Value of assets issued by the same issuer / Total Collateral Value

Collateral Value of assets issued by the same issuer is the dirty post-haircut value (Contract Value) of all assets
held on the Margin Call contract and issued by the same issuer.

Total Collateral Value is the dirty post-haircut value (Contract Value) of all assets held on the margin call contract.

• Breakdown by Country - Usage (%) = Collateral Value of the collateral assets issued by issuers from the same
country / Total Collateral Value

Collateral Value of the collateral assets issued by issuers from the same country is the dirty post-haircut value
(Contract Value) of all assets held by the Margin Call contract and issued by the issuers from the same country.

Total Collateral Value is the dirty post-haircut value (Contract Value) of all assets held on the Margin Call contract.

The collateral assets must be grouped by Issuers domiciled in the same country and be determined by the
Country field in the product definition.

• Breakdown by Ultimate Issuer - Usage (%) = Collateral Value of collateral assets issued by an ultimate issuer /
Total Collateral Value

The ultimate issuer is based on the product code ULTIMATE_ISSUER_ID.

Collateral Value of the collateral asset issued by an ultimate issuer is the dirty post-haircut value (Contract Value)
of all assets held by the Margin Call contract and issued by issuers belonging to the same group.

Total Collateral Value is the dirty post-haircut value (Contract Value) of all assets held on the Margin Call contract.

There are additional columns available in Collateral Manager to clarify the allocation process when the Percentage
Basis is Total Collateral Value.

Column Name Calculation Description

Total Collateral
(Current)

Total Prev Mrg + Cash
Margin + Security Margin

Total Collateral column at Margin Call Entry level

Total Collateral
(Projected)

Total Prev Mrg + Global
Required Margin

Used as the denominator in the project concentration limit
calculation
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Column Name Calculation Description

Max Value
(Current)

Total Collateral (Current)
× Maximum % of the
concentration limit rule

Maximum amount of collateral that can be added in the
concentration limit bucket without breaching the limit. Concentration
limit calculation based on the Total Collateral (Current)

Max Value
(Projected)

Total Collateral
(Projected) × Maximum %
of the concentration limit
rule

Maximum projected amount of collateral that can be added in the
concentration limit bucket without breaching the limit. Concentration
limit calculation based on the Total Collateral (Projected)

Usage(%)
(Projected)

Total Allocation ÷ Total
Collateral (Projected)

With current allocations and previous collateral, this column gives
the Usage (%) in the concentration bucket, with the assumption that
the contract is fully covered (Remaining Margin = 0). Concentration
limit calculation based on the Total Collateral (Projected)

Available (Total)
(Projected)

Total Allocation – Max
Value (Projected)

How much collateral can be added to the concentration limit bucket
if the contract is fully covered (Remaining Margin = 0)

Status (Projected) “In Limit” if Usage (%)
(Projected) < Maximum %
of the concentration limit
rule.

“Out of limit” if Usage (%)
(Projected) > Maximum %
of the concentration limit
rule

Status under the assumption that the contract is fully covered
(Remaining Margin = 0). Concentration limit calculation is based on
the Total Collateral (Projected)

Total Issued
Usage(%) = Issue Nominal ÷ Total Issued

where Total Issued is the value stored in the Total Issued field specified in the product definition of the bond or equity.

Net Asset Value
Available for all Breakdown types

Usage(%) = Collateral Value of assets considering the concentration limit Scope and the breakdown / market quote
(Fund.<Fund Name linked to the contract legal entity>.NAV * FX.<Fund currency to Contract Currency>)

Average Daily Trading Volume
Available only for Security Breakdown

The ADTV is the market data from the market data providers specific to a given asset. This should be stored in a
specific market quote in Calypso <Product Name>.<Bond Name>.ADTV. For example:

Bond.<Bond Quote Name>.ADTV for bonds
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Equity.<Equity Quote Name>.ADTV for equities

Usage(%) = quantity of the bond held on the position / Bond.<Bond Quote Name>.ADTV

Usage(%) = quantity of the equity held on the position / Equity.<Equity Quote Name>.ADTV

Total Net Balance
Computes the concentration limits based on the current Total Exposure Amount (Net Balance) of the contract.
Available for all breakdowns.

For example: 

Contract Total Exposure (Net Balance) = 1,000,000

French Bond allocated = 300,000 in value

Limit = BOND issued by French government should not exceed 40% of Total Exposure Amount

Limit = 300,000 / 1,000,000 = 30%

Status = In Limit

Margin Required
Computes the concentration limits based on the Margin Required of the contract.

Usage(%) = Cash allocated / Margin required

8.2 .3 Concentrat ion Scope
Concentration scope is used to determine what type of concentration rule configuration is used, either Contract or
Liability. A Liability configuration is used for Cover Distribution. A Liability concentration can be defined at the liability
group (across all liability currencies) or each liability currency within a liability group. The default Concentration Scope
is Contract.
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Fields Description

Scope Select either Contract or Liability. Contract is the default selection.

Liability
Config

If Liability is selected for the Scope, this field is made available for selection. You may select from any of
the configured Liability Groups. The selection defaults to ANY.

Liability
Currency

If Liability is selected for the Scope, this field is made available for selection. You may choose a specific
liability currency for the concentration. The selection defaults to ANY.

Netted
Liability

If Liability is selected for the Scope, this field is made available for selection. Selecting this includes
liability offsetting which allows the use of positive liabilities to offset negative liabilities. This flag is used
solely for concentration purposes. This is not affected by the Liability Offsetting rule in the Liability Group
Configuration.

8.3 Concentrat ion Limits and Margin Cal l / Clearing Member Con-
tracts
After all of the concentration rules have been created, they can be added to the margin call or clearing member
contract.

Once Concentration rules have been created for a contract, they will apply for each allocation on that contract.

Fields Description

Credit Limit A credit limit may be specified for the counterparty. The credit limit is the amount that a client can
borrow against the pledged securities. It is possible for the counterparty to pledge securities with a
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Fields Description

value above the limit but the value that exceeds the limit is not included in the total collateral value.
The amount is in the contract currency and may vary from contract to contract.

Additionally, there are certain columns that can be displayed in Collateral Manager pertaining to the
Credit Limit. They are:

• Credit Limit – static data from the margin call contract

• Margin (including Credit Limit) – displays the smaller of these two values:

– Total Collateral (previous collateral and today’s collateral)

– Credit Limit (static data from the margin call contract)

• Amount Over Credit Limit

– If Credit Limit > Total Collateral then this field displays 0

– If Credit Limit < Total Collateral then this field displays the difference between the two
(Credit Limit – Total Collateral)

• Available Credit Limit

– If Credit Limit < Total Collateral then this is 0

– If Credit Limit > Total Collateral then this displays the difference between the two (Total
Collateral – Credit Limit)

• Credit Limit Status – either Over the Limit or Under the Limit

Position Type Select THEORETICAL or ACTUAL

Defines which type of position you would like to use for your 'previous allocation'.

Check
Concentration
On

Select either Both, Outgoing or Incoming.

• Both - If the concentration limit should be checked on incoming and outgoing collateral.

• Outgoing - If the concentration limit should be checked on outgoing collateral only. (For
example, if the Global Required Margin < 0, then the PO owes collateral to the counterparty.)

• Incoming - If the concentration limit should be checked on incoming collateral only. (For
example, if the Global Required Margin > 0, then the counterparty owes collateral to the PO.)

8.4 Concentrat ion Limit Process
To do a manual allocation once the exposure has been calculated in the Collateral Manager, you can allocate it in the
Allocation window.
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There are two ways of allocating collateral:

• Select the collateral (Cash or Security) in the Security Browser section of the window, then double-click the
collateral. It will then appear in the Allocation portion of the window below.

• In the Allocation section of the window, select ISIN from the drop-down list. Either enter a list of ISIN codes of the

securities or begin typing the first few letters of the code to view available securities in Calypso. Click to
insert the securities.

Below is an example of a completed allocation.
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Select the Concentration tab to display the Concentration Limits window.

The default columns in this panel are described below.

Column Description

Previous
Allocation

Value of previously allocated collateral

Current
Allocation

Value of today's allocated collateral

Total
Allocation

The Previous Allocation + Current Allocation

Min (Value) From the contract / concentration definition.

The minimum amount the concentration limit can be in value. It is the value under which the limit will
not be accepted.

This is applicable for the Category rule type only.

Max (Value) From the contract / concentration definition.

The maximum amount the concentration limit can be in value. It is the value over which the limit will not
be accepted.

Available
(Value)

For limit type CATEGORY, equal to Max (Value) - Used (Value)

For limit types ISSUE and ISSUER, not applicable.

Usage
(Value)

For limit type CATEGORY, equal to Used (Value) / Max (Value)

for limit types ISSUE and ISSUER, not applicable.
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Column Description

Min (%) From the contract / concentration definition.

The minimum for the concentration ratio. It is the percentage under which it will not be accepted.

Max (%) From the contract / concentration definition.

The maximum for the concentration ratio. It is the percentage over which it will not be accepted.

Usage (%) For limit type CATEGORY, equal to Used (Value) / Global Required Margin

For limit type ISSUE, equal to Used (Value) / Total issue amount as defined in the product definition

For limit type ISSUER, equal to Used (Value) / Sum of Used (Value) for all bonds of the same category

Available (%) For all limit types, equal to Max (%) - Used (%)

Status If the Available (Value) or the Available (%) is >, the status indicates 'in limit'.

If the Available (Value) or the Available (%) is ≤ 0, the status indicates 'out of limit'.

Note: A Concentration Limit column can be added in Collateral Manager Results panel. This field will
indicate if the concentration limit is 'out of limit'.

8.4.1 Graphics
You may add a graph based on the concentration calculations in both the Allocation window and in the Collateral
Manager. The steps required to set this up are the same for both.

To view a graphic, select > Create. You then can select what sort of graph you would like to generate. (In the
screen shot below, the allocation value is segregated by concentration rule type.
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The graph can be added to the Allocation window as a new panel by choosing > Add. The list of all the graphs
created and saved appears. Choose the graph you would like and click Select. As a result, a new panel appears in the
bottom section of the screen.
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8.4.2 History
You may view the history of your concentration limits from the Concentration History panel.
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9. Rehypothecation of Collateral
The term Rehypothecation refers to the ability for a collateral receiver to reuse collateral provided by its counterparty.
If the collateral is rehypothecable, then it can be redelivered to another counterparty to fulfill a margin obligation. If
the collateral is not rehypothecable, then it cannot be reused and must remain in a specified account.

The setup of this functionality, requires two settings. One setting is a book attribute and the other is in the Details
panel of the Margin Call Contract. Both the book and contract configurations need to be done for the
Rehypothecation functionality to be enabled.

Warning messages appear if an attempt is made to receive into a book or pay from a book which is not eligible
according to the Rehypothecation settings of the Contract.

9.1 Rehypothicat ion Book Attr ibutes
The book attribute Margin_Book_Type indicates whether a book can be used for rehypothecated assets. There are
three options for this attribute. This attribute must be set in some way to enable the Rehypothecation functionality.

The Book window is displayed from Calypso Navigator by selecting, Configuration > Books & Bundles > Trading
Book.

• A selection of Rehypothecable means that rehypothecable collateral (collateral that is able to be reused on a
different contract) can come into the book. The collateral that comes into the book will then be redelivered to
another contract.

• A selection of Non Rehypothecable means that only non-rehypothecable collateral can go into the book. The
collateral will stay there until it is returned back to the counterparty.

• A selection of PO Assets means that the collateral in the book belongs to the PO and the PO can do with it as it
chooses.

If a book has no selection, it will function the same as a book with a PO Assets selection.

The Optimizer will treat the books with set attributes as either eligible or ineligible as appropriate.
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9.2 Rehypothecation Setup in Margin Cal l Contract
The settings in the Parties panel of the margin call contract determine if the contract has the ability to receive and/or
re-pledge collateral or if the contract is prohibited from doing so. The movements of the collateral are restricted to
contracts that share the same Processing Org (PO).

Select the Enable Rehypothecation flag to enable the enable the Rehypothecation functionality in the Margin Call
contract and to display the Rehypothecation related fields, Collateral Rehypothecation and Accept Rehypothecated
Assets.
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• Collateral Rehypothecation: A selection in this field indicates that either the PO or the CP in the contract are
permitted to rehypothecate collateral. The options are that BOTH cash and securities can be rehypothecated,
CASH can be rehypothecated, SECURITY can be rehypothecated or no collateral from the contract can be
rehypothecated (NONE).

• Accept Rehypothecated Assets: A selection in this field indicates that either the PO or the CP in the contract
accept rehypothecated collateral. The options are that BOTH cash and securities are accepted, only CASH is
accepted, only securities (SECURITY) are accepted or no rehypothecated collateral is accepted (NONE).

 Ⓘ On the PO side of the contract, the Accept Rehypothecated Assets flag is for information purposes only
because it is not possible to govern what collateral the CP sends.

 Ⓘ On the CP side of the contract, the Collateral Rehypothecation flag is for information purposes only
because it is not possible to govern what CP does with their collateral.

NOTE: If the Rehypothecation Rules are set in the contract but none of the contract's Eligible Books do not have the
appropriate MARGIN _BOOK_TYPE set, the Rehypothecation logic will not work and the user will not see any error
messages.

Incoming cash and non-cash collateral against a non-rehypothecable contract where the allocation book has a null
value for MARGIN _BOOK_TYPE BOOK ATTRIBUTE impacts non-rehypothecable balances.

In this scenario, delivery to PO and return to CP transfers from allocations for contracts which have the Enable
Rehypothecation flag selected, and which have the Collateral Rehypothecation field set to NONE for the PO side of
the Parties tab are impacted.
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